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1 Представляем EssentialPIM Free

Добро пожаловать в EssentialPIM!

EssentialPIM является профессиональным инструментом управления
персональной информацией. Он возьмет на себя напоминание о встречах и
делах, хранение контактов и заметок в удобной для использования форме.
Среди наиболее значительных функций EssentialPIM можно отметить:

Резервное копирование данных
Иерархическая структура заметок
Синхронизация с устройствами на базе Android и iOS
Импорт данных из Outlook

...и множество других функций.

1.1 Основные функции

EssentialPIM - это полнофункциональный менеджер персональной информации,
основными функциями которого являются:

Удобство и простота использования. Расширенные клавишные комбинации
увеличат вашу скорость работы и эффективность. 
Безопасность. Все данные могут быть зашифрованы алгоритмом шифрования
AES (Rijndael).
Широкие возможности экспорта и импорта. Вы можете импортировать и
экспортировать в следующие форматы HTML, RTF, CSV, TXT и TreePad. Вы
можете осуществить полную синхронизацию с устройствами на Android и
iOS.
Удобное автоматическое резервное копирование.
Использование базы с открытым исходным кодом - Firebird. Опытные
пользователи и системные администраторы оценят возможности гибкой
настройки и доступность множества инструментов администрирования.

2 Лицензионное соглашение

EssentialPIM(tm) License Agreement.

EssentialPIM is FREEWARE.

Astonsoft Ltd. EssentialPIM VERSION 4 END-USER LICENSE AGREEMENT

IMPORTANT-READ CAREFULLY: This EssentialPIM End-User License Agreement
("EULA") is a legal agreement between you (either an individual or a single entity)
and Astonsoft Ltd. for the EssentialPIM SOFTWARE(s) identified above, which
includes the User's Guide, any associated SOFTWARE components, any media, any
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printed materials other than the User's Guide, and any "online" or electronic
documentation ("SOFTWARE"). By installing, copying, or otherwise using the
SOFTWARE, you agree to be bound by the terms of this EULA. If you do not agree to
the terms of this EULA, do not install or use the SOFTWARE. If the SOFTWARE was
mailed to you, return the media envelope, UNOPENED, along with the rest of the
package to the location where you obtained it within 30 days from purchase.

1. The SOFTWARE is licensed, not sold.

2. GRANT OF LICENSE.
(a) Freeware.  You may use the SOFTWARE without charge. Astonsoft Ltd. may
place announces of its other PIM-related products into EssentialPIM. Astonsoft Ltd.
will not monitor the content of your use (e.g., sites selected or files used). 
(b) Redistribution of EssentialPIM. You may make copies of the evaluation SOFTWARE
as you wish; give exact copies of the original SOFTWARE to anyone; and distribute
the SOFTWARE in its unmodified form via electronic means (Internet, BBS's,
Shareware distribution libraries, CD-ROMs, etc.). You may not charge any fee for the
copy or use of the evaluation SOFTWARE itself, but you may charge a distribution
fee that is reasonably related to any cost you incur distributing the evaluation
SOFTWARE (e.g. packaging). You must not represent in any way that you are selling
the SOFTWARE itself. Your distribution of the SOFTWARE will not entitle you to any
compensation from Astonsoft Ltd..  You must distribute a copy of this EULA with any
copy of the SOFTWARE and anyone to whom you distribute the SOFTWARE is
subject to this EULA.

3. RESTRICTIONS.  You may not reverse engineer, de-compile, or disassemble the
SOFTWARE, except and only to the extent that such activity is expressly permitted
by applicable law notwithstanding this limitation. You may not rent, lease, or lend the
SOFTWARE. You may permanently transfer all of your rights under this EULA,
provided the recipient agrees to the terms of this EULA.  You may not use the
SOFTWARE to perform any unauthorized transfer of information (e.g. transfer of files
in violation of a copyright) or for any illegal purpose.

4. SUPPORT SERVICES. Astonsoft Ltd. may provide you with support services related
to the SOFTWARE. Use of Support Services is governed by the Astonsoft Ltd. polices
and programs described in the user manual, in online documentation, and/or other
Astonsoft Ltd.-provided materials, as they may be modified from time to time. Any
supplemental SOFTWARE code provided to you as part of the Support Services shall
be considered part of the SOFTWARE and subject to the terms and conditions of this
EULA. With respect to technical information you provide to Astonsoft Ltd. as part of
the Support Services, Astonsoft Ltd. may use such information for its business
purposes, including for product support and development. Astonsoft Ltd. will not
utilize such technical information in a form that personally identifies you.

5. TERMINATION. Without prejudice to any other rights, Astonsoft Ltd. may
terminate this EULA if you fail to comply with the terms and conditions of this EULA.
In such event, you must destroy all copies of the SOFTWARE.

6. COPYRIGHT. The SOFTWARE is protected by United States copyright law and
international treaty provisions. You acknowledge that no title to the intellectual
property in the SOFTWARE is transferred to you. You further acknowledge that title
and full ownership rights to the SOFTWARE will remain the exclusive property of
Astonsoft Ltd. and you will not acquire any rights to the SOFTWARE except as
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expressly set forth in this license. You agree that any copies of the SOFTWARE will
contain the same proprietary notices which appear on and in the SOFTWARE.

7. NO WARRANTIES. Astonsoft Ltd. expressly disclaims any warranty for the
SOFTWARE. THE SOFTWARE AND ANY RELATED DOCUMENTATION IS PROVIDED "AS
IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING,
WITHOUT LIMITATION, THE IMPLIED WARRANTIES OR MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE, OR NONINFRINGEMENT. THE ENTIRE RISK ARISING OUT
OF USE OR PERFORMANCE OF THE SOFTWARE REMAINS WITH YOU. 

8. LIMITATION OF LIABILITY. IN NO EVENT SHALL Astonsoft Ltd. OR ITS SUPPLIERS
BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, SPECIAL, INCIDENTAL, OR INDIRECT
DAMAGES OF ANY KIND ARISING OUT OF THE DELIVERY, PERFORMANCE, OR USE OF
THE SOFTWARE, EVEN IF Astonsoft Ltd. HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. IN ANY EVENT, Astonsoft Ltd.'S LIABILITY FOR ANY CLAIM,
WHETHER IN CONTRACT, TORT, OR ANY OTHER THEORY OF LIABILITY WILL NOT
EXCEED THE GREATER OF U.S.$1.00 OR LICENSE FEE PAID BY YOU.

9. U.S. GOVERNMENT RESTRICTED RIGHTS. The SOFTWARE is provided with
RESTRICTED RIGHTS. Use, duplication, or disclosure by the Government is subject to
restrictions as set forth in subparagraph (c)(1)(ii) of The Rights in Technical Data
and Computer SOFTWARE clause of DFARS 252.227-7013 or subparagraphs (c)(i) and
(2) of the Commercial Computer SOFTWARE-Restricted Rights at 48 CFR 52.227-19,
as applicable.

3 О справочном пособии

Данное справочное пособие призвано познакомить вас с функциями и приемами
работы с EssentialPIM. Для более удобной подачи информации в тексте
используется ряд условных обозначений, которые представлены ниже.

Жирным шрифтом в тексте обозначены элементы интерфейса так как они
написаны в программе. К примеру, диалоговые окна, вкладки, кнопки, о которых
идет речь, либо которые надо нажать.

Полезный прием, упрощающий работу с описываемой выше функцией,
либо полезные клавиатурные сочетания для быстрого доступа к
функции.

Информация к сведению, на которую следует обратить внимание.

Особо важная информация, обязательная к исполнению для корректной
работы программы.
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4 Основной вид EssentialPIM

EssentialPIM включает в себя множество функций для управления
персональными данными. В то же время большинство из них интуитивно понятны
благодаря простому интерфейсу. Данное руководство описывает приемы
эффективной работы с программой, чтобы вы могли легко и удобно
организовывать и синхронизировать данные.

Ниже представлено рабочее окно EssentialPIM:

Секция 1: Главное меню программы. Оно содержит все команды для управления
программой. Содержимое меню может меняться в зависимости от активного в
данный момент модуля.

Секция 2: Панель навигации, она позволяет переключаться между модулями и
видами внутри модулей. Панель навигации может быть представлена в
свернутом либо развернутом виде. Переключение между видами панелей
осуществляется при помощи кнопки вверху панели.
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Набор используемых модулей можно настроить тут: Сервис ->
Настройки -> Модули, либо используя контекстное меню, кликнув по
панели правой кнопкой мыши.

Секция 3: Календарь, который может использоваться для поиска не занятого
дня, а также для быстрой навигации.

В области календаря можно включить несколько месяцев, для этого
надо расширить область календаря, перетащив выше линию между
календарем и панелью модулей, удерживая левую кнопку мыши.

Секция 4: Панель инструментов, позволяет совершать различные действия с
записями текущего модуля. Инструментарий панели инструментов разнится в
зависимости от активного модуля.

Секция 5: Главное окно модуля, его вид меняется в зависимости от активного,
в данный момент, модуля.
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5 Работа с EssentialPIM

5.1 Работа с файлами баз данных EPIM Pro

5.1.1 Запуск программы

Первый запуск

При первом запуске EssentialPIM создает тестовый файл test.epim, содержащий
примеры записей которые можно создавать в программе. Можно как продолжить
работу с этим файлом, так и создать новый в меню Файл -> Новый -> Файл
базы данных ЕПИМ

При создании новой базы данных EssentialPIM Pro создает временный файл вида
temp.32B51682.epim. Для завершения создания файла следует его сохранить
воспользовавшись командой Файл -> Сохранить/Сохранить как, либо
подтвердить сохранение при закрытии базы или программы. При сохранении
файлу рекомендуется присвоить какое-нибудь значимое имя, отличное от
временного во избежание путаницы в будущем.

Следует заметить, что слово "test" в названии файла не означает, что
данный файл, либо программа работают в тестовом режиме. Это лишь
имя файла, которое может быть изменено.

Последующие запуски

EssentialPIM запоминает последний файл с которым вы работали и открывает его
автоматически при следующем старте программы. Программа также хранит
список из трех последних открывавшихся файлов. Его можно найти в меню 
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Файл.

Этим меню можно воспользоваться для быстрого доступа к последним файлам, а
также для быстрого поиска вашего файла, если EssentialPIM по какой-то
причине не открыл файл автоматически.

Открытие любой базы данных EssentialPIM возможно также через меню Файл ->
Открыть, где в проводнике надо указать расположение требуемого *.epim
файла.

По умолчанию EssentialPIM хранит файлы баз данных в нижеследующих
папках:
C:\Documents and Settings\User Name\Application Data\EssentialPIM\ - для
XP
C:\Users\User_name\AppData\Roaming\EssentialPIM\ - для Vista, 7 и 8
Данные папки не являются обязательными для хранения баз данных
EssentialPIM. Используемые файлы могут быть перенесены в любое
удобное для пользователя место на жестком диске и открыты в
программе.

При использовании нескольких *.epim файлов можно создать ярлыки по
которым EssentialPIM будет принудительно открывать нужный файл. Для
этого в свойствах ярлыка программы в поле Объект через пробел надо
дописать путь к требуемому *.epim файлу.

Параметры запуска и работы EssentialPIM

EssentialPIM может запускаться как вручную через ярлык, так и автоматически
при старте Windows. Программа также может следить чтобы было открыто не
больше одной копии программы. Эти и другие параметры могут быть установлены
в настройках Сервис -> Настройки -> Общие.
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Сворачивать в трей - окно программы сворачивается системный трей (фон) а
не на панель задач при минимизации окна.
Кнопка Закрыть как Свернуть - программа сворачивается на панель задач при
попытке её закрыть. Так можно быть уверенным, что ни одно напоминание не
будет пропущено из-за случайного закрытия программы.
Автозагрузка с Windows - автоматически запускает EssentialPIM Pro при
старте системы.
Только одна активная программа EssentialPIM - при попытке запустить
дополнительную копию программы, активируется уже запущенная копия.
Автоматическая проверка обновлений - если включено, раз в несколько
дней EssentialPIM автоматически проверяет наличие обновлений. Можно также
проверить обновления вручную нажав кнопку Проверить.
Вид при старте программы - позволяет установить какой модуль загружать на
старте.

При одновременной активации параметров Сворачивать в трей и
Автозагрузка с Windows может возникнуть ситуация, когда значок
EssentialPIM оказывается среди скрытых значков системной панели и
создается впечатление, что программа не запущена. В таких случаях
при попытке запустить программу новая копия выдает ошибку, что
требуемый файл данных занят, что является верным, так как файл
действительно занят уже работающей программой. Чтобы избежать
подобной ситуации надо включить постоянное отображение значка
EssentialPIM Pro в настройках системной панели Windows. Либо в
дополнение активировать опцию Только одна активная программа
EssentialPIM. В этом случае, иконка программы всегда будет на виду,
случайная попытка запуска второй копии EssentialPIM Pro будет
активировать уже работающую копию программы из трея.

Shift+Ctrl+S - глобальное сочетание клавиш, вызывающее из трея и
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сворачивающее в трей окно программы.

5.1.2 Архивация данных

Обеспечение сохранности пользовательских данных является неотъемлемой
частью функционала EssentialPIM. Для этого, помимо регулярного
автосохранения данных, в программе предусмотрена система архивации
(резервного копирования) данных. Это практически полностью исключает
потерю данных в любых обстоятельствах. По умолчанию, EssentialPIM создает
резервные копии файла данных в той же папке где расположен сам *.epim файл.
Это параметр можно изменить в настройках через меню Сервис -> Настройки -
> Архивы.

Включить архивацию - включает/отключает создание резервных копий. Мы
настоятельно не рекомендуем отключать этот параметр, иначе в случае какого-
либо сбоя восстановление данных может быть очень затруднено.

Папка для архивов - этот блок позволяет указать куда сохранять резервные
копии. Можно сохранять в папку где находится база данных (по умолчанию), в
стандартную папку для временных файлов Windows, либо указать любую
удобную папку на жестком диске, для этого нажмите кнопку Обзор и укажите
необходимую папку.

При указании папки для создания резервных копий следует указывать
папку на локальном диске. EssentialPIM не может сохранять файлы на
сетевых дисках, либо сетевых хранилищах (NAS).

Типы архивов и файлов, создаваемые EssentialPIM

my_database.epim – стандартный файл данных EssentialPIM, созданный
пользователем (новый файл всегда можно создать через меню Файл -> Новый -
> Файл данных EPIM). Путь к открытому в данный момент файлу можно найти 
в заголовке окна программы, либо через меню Файл -> Управление базой
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данных.

my_matabase.backup_20130118_1401.epim – стандартная резервная копия
созданная в соответствии с параметрами архивации. Числа в названии
обозначают дату (в формате ггггммдд) и время (в 24-х часовом формате)
создания архива. Для экономии места на жестком диске, архивы создаются в
сжатом виде, поэтому  они могут быть существенно меньше основного файла
данных. Чтобы восстановить данные из архива нужно просто открыть архив в
программе как обычный файл через меню Файл -> Открыть.

При переносе данных на другой ПК, достаточно скопировать основной
файл данных и открыть его в EssentialPIM. Необязательно осуществлять
перенос данных через резервную копию.

restored.my_database.epim – файл восстановленный из архива. Мы
рекомендуем переименовывать (достаточно удалить слово "restored." из имени)
файл после восстановления, чтобы избежать возможной путаницы в именах
будущих архивов.

backup_convert_200130118_1521.epim.bak – данный тип файлов создается
при переходе на новую версию программы. EssentiaPIM создает резервную
копию базы данных перед тем как сконвертировать ее в новый формат для новой
версии. В случае если что-то пойдет не так в процессе обновления, всегда
можно вернуться к предыдущей версии файла. Можно попытаться открыть его
снова, либо открыть в предыдущей версии программы. Чтобы открыть файл
данного типа, надо сначала удалить расширение ".bak", а затем открыть как
стандартный файл через меню Файл -> Открыть. Предыдущие версии
EssentialPIM можно скачать отсюда - http://www.essentialpim.com/vv

5.1.3 Обслуживание базы данных

В нормальных условиях EssentialPIM автоматически выполняет все необходимые
действия по обслуживанию файла базы данных. Тем не менее, некоторые
действия могут быть выполнены вручную, если возникнет такая необходимость.
Ниже рассмотрено, что можно сделать с файлом вручную, и какие результаты
получить после этого.

Оптимизация базы данных

Эта процедура оптимизирует базу данных удаляя некоторую устаревшую
служебную информацию, что делает файл данных меньше по размеру и в
некоторых случаях ускоряет работу программы. Запустить оптимизацию можно
через меню Файл -> Управление базой данных -> Оптимизация.
Оптимизация базы является профилактической мерой и в обычных условиях
EssentialPIM выполняет ее автоматически, когда для этого выполняется ряд
установленных условий, другими словами, когда возникает такая
необходимость.

http://www.essentialpim.com/vv
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Прежде чем запускать оптимизацию базы данных убедитесь, что в
данный момент нет активного процесса синхронизации, либо получения/
отправки почты. В случае, если таковые имеются, кнопка Оптимизация
будет неактивной. Чтобы остановить процессы, нажмите кнопку 
Остановить все в окне статуса синхронизации, или получения почты.

Архивирование старых данных

Когда база данных используется достаточно долго, вполне очевидно, что в ней
может накопиться некоторое количество старых и уже не актуальных данных.
Удаление старых данных сделает базу данных меньше и, возможно, улучшит
производительность. Для этой задачи у нас есть бесплатная дополнительная
программа - EPIM Arhiver/DupeRemover. EPIM Arhiver может произвести
следующие действия:
- Переместить старые записи в Корзину для текущей базы данных
- Переместить записи в отдельный файл для последующего хранения
- Удалить старые записи
Более подробную информацию по использованию EPIM Archiver/DupeRemover
можно найти в справке самой программы.

Удаление дубликатов

EPIM Archiver/DupeRemover может быть также использован и для поиска и
удаления дубликатов. Программа сканирует все модули на предмет дубликатов,
после чего выдает список с результатами. По умолчанию предлагается удалить
все найденные дубликаты, но также есть возможность вручную указать какие
записи удалять, а какие нет. Все удалённые записи помещаются в корзину,
откуда их можно удалить окончательно, либо восстановить.

Для работы программы должна быть соблюдена совместимость версий с
EssentialPIM. Основной номер версии EPIM Archiver/DupeRemover'a и
EssentialPIM'a должны совпадать. Например, EPIM Archiver/DupeRemover
версии 5.5 будет работать с файлом EssentialPIM'a версии 5.53, но не
будет работать с файлом созданным в EssentialPIM 4.5.

5.2 Сегодня

Модуль Сегодня представляет собой обобщённый вид событий на ближайшие
дни из нескольких модулей программы. Рабочая область окна разделена на
четыре блока:

http://www.essentialpim.com/ru/pc-version/supplementary-apps
http://www.essentialpim.com/ru/pc-version/supplementary-apps
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Календарь - показывает список ближайших событий из модуля Календарь. По
умолчанию список состоит из событий на три дня.
Дела - аналогично разделу календарь, показывает список дел на ближайшие
дни (по умолчанию на три дня).
Письма - показывает в каких учетных записях и в каких папках есть
непрочитанные письма.
Годовщины - здесь отображаются события которые EssentialPIM Pro генерирует
автоматически из полей c форматом "дата" в контактах. По умолчанию это дни
рождения. Более подробно о полях формата "дата" можно узнать тут.

Настройка модуля Сегодня

Модуль Сегодня зачастую используется как сводка важных событий на
ближайшее время, поэтому очень важно, чтобы в списке были все важные
события, и в то же время, чтобы список не был завален ненужными, либо
второстепенными записями. Для этого EssentialPIM предлагает набор настроек,
позволяющих гибко настроить модуль Сегодня под требуемые задачи.
Настройки модуля находятся тут - Сервис -> Настройки -> Сегодня.
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Настройки разделены на три раздела, каждый из которых отвечает за
соответствующий блок в модуле Сегодня. Чекбокс возле названия включает/
отключает показ соответствующего блока.  
Запускать EPIM на форме Сегодня - при включенной опции, EssentialPIM
стартует с модуля Сегодня, если опция отключена, то EssentialPIM запускается
на том модуле, который был отрыт при закрытии программы.
Список Задач на - позволяет установить задачи за какой промежуток
показывать в модуле Сегодня.
Список Дел с началом или сроком выполнения на (дней вперед) -
показывает дела которые начинаются, либо заканчиваются в ближайшие Х дней.
Показывать списки дел без дат - показывает/прячет дела в которых не
введены даты начала и конца.
Не показывать выполненные Задачи/Дела - показывает/скрывает записи,
которые отмечены как выполненные.
Показать Задачи/Дела для выбранных категорий - позволяет выбрать
записи с какими присвоенными категориями показывать в модуле Сегодня.
Показывать выбранные папки - позволяет выбрать какие папки показывать в
блоке Письма.
Показывать Годовщины - включает/отключает раздел с годовщинами.

Следует иметь ввиду, что настройки модуля Сегодня не влияют на
настройки отображения событий в самих модулях Календарь и Дела,
равно как и наоборот. Поэтому, если в модуле Сегодня отсутствует то
или иное событие, убедитесь, что оно соответствует параметрам
отображения модуля Сегодня.
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5.3 Календарь

5.3.1 Pабота с календарем

Календарь является центральной частью программы EssentialPIM и служит для
планирования и контроля событий. В зависимости от текущих задач, календарь
может быть включен в различных режимах (День, Неделя, Месяц, Год,
Таблица). Переключаться между ними можно через меню Вид, либо с помощью
панели навигации слева.

День/Неделя

Два этих режима являются идентичными, с той лишь разницей, что первый
показывает задачи на определенный день, а второй на неделю.
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Основную часть рабочей области занимает временная сетка, позволяющая
легко ориентироваться в уже созданных задачах, находить свободное время, а
также создавать новые задачи на нужное время. Задачи, имеющие время начала
и конца в течении одного дня, находятся внутри сетки, задачи длительностью
целый день и больше отображаются в верхней части календаря сразу под датой.

Слева находится шкала времени масштаб которой можно изменить через меню
Вид -> Масштаб, либо через контекстное меню:

Рабочее время в сетке отмечено более светлым цветом, входные дни - красным
шрифтом. Изменить рабочее время и ряд других параметров отображения
календаря можно в настройках модуля Календарь.
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Месяц/Год

Режимы Месяц и Год также идентичны по функциональности. Данные режимы
являются удобным инструментом для управления событиями на
продолжительные периоды времени.

Таблица

В некоторых случаях, когда требуется более детальный анализ задач,
классических видов календаря может оказаться не достаточно. Для этого в
EssentialPIM Pro есть табличный вид календаря. В этом режиме задачи
представлены списком в виде таблицы.

Такой режим позволяет работать с событиями практически также как в
табличном процессоре. Все параметры могут быть изменены напрямую в ячейках
таблицы. 
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Вверху над таблицей можно указать границы дат, в рамках которых следует
отображать события. При отключенном чекбоксе возле параметров дат, в
таблицу будут включены все события календаря. 

Любой столбец может быть отключен, либо включен через контекстное меню
заголовка таблицы.

Записи таблицы могут быть отсортированы по одному или нескольким столбцам,
для этого надо щелкнуть левой кнопкой мыши по заголовку столбца, значок
стрелочки в заголовке столбца показывает порядок сортировки, второй щелчок
меняет порядок сортировки на противоположный. Для сортировки по нескольким
столбцам надо при щелчке по заголовкам столбцов удерживать клавишу Ctrl.

Для быстрого переключения между видами календаря можно
воспользоваться следующими комбинациями горячих клавиш:
Ctrl+D - День
Ctrl+W - Неделя
Ctrl+M - Месяц
Ctrl+R - Год
Ctrl+E - Таблица

Настройки календаря

Для большего удобства использования календаря, EssentialPIM позволяет
изменить ряд настроек. Окно настроек открывается через меню Сервис ->
Настройки -> Календарь.
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Рабочее время - позволяет настроить время начала и конца рабочего дня. Этот
отрезок будет иметь более светлый оттенок в календаре.
Показывать только рабочие часы - скрывает/показывает не рабочие часы в
дневном и недельном видах.
Автовыбор часовой шкалы - растягивает разметку календаря на всю рабочую
область экрана, если по умолчанию отображаемые часы не занимают все
пространство рабочей области
Рабочая неделя - аналогично рабочим часам позволяет отметить какие дни
недели считать рабочими.
Показывать только рабочие дни - скрывает/показывает выходные дни.
Первый день недели - позволяет установить какой день недели будет первым
в недельном и месячном видах.
В режиме таблицы помнить введенные вручную даты - запоминает
диапазон дат установленных в табличном виде.
Показывать категории - определяет в каком виде показывать категории в
табличном виде (не влияет на остальные виды).
Показывать сетку - включает/выключает сетку ячеек в табличном виде.
Цвет фона - позволяет установить цвет фона, который будет взят за основу во
всех режимах календаря кроме табличного.

5.3.2 Добавление задачи

Добавить новую задачу можно несколькими способами. Один из способов
нажать на кнопку Добавить на панели Действия, либо через меню Действия -
> Новая Задача.
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Можно также создавать задачи прямо в календаре следующими способами:

Удерживая левую кнопку мыши выделите временной отрезок необходимый для
события, затем отпустите кнопку, это откроет окно создания/редактирования
задачи с уже заполненными полями начала и окончания. В окне можно ввести
остальные данные, такие как тема, категория, заметки и прочие.

Двойной клик по любой точке в календаре создает задачу в данной точке и
откроет окно создания/редактирования задачи.

Для быстрого ввода задачи на определенное время можно просто кликнуть один
раз в нужной точке календаря и начать вводить тему задачи, при этом будет
создана новая задача аналогично предыдущему способу, но при этом не будет
открыто окно редактирования задачи.

Shift+Ctrl+T - глобальное сочетание клавиш для добавления новой
задачи (работает даже когда окно программы не активно в данный
момент)
Задачу также можно добавить через меню Файл -> Новый -> Задача
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5.3.3 Редактирование задачи

Задачи могут быть отредактированы в любой момент. При двойном клике по
задаче открывается диалог Свойства задачи.

Начало - время начала задачи.
Конец - время окончания задачи.
Длительность - автоматически вычисляет длительность задачи; длительность
можно также указать вручную, в этом случае будет автоматически подсчитано
время окончания задачи.
Тема - название задачи которое отображается в календаре.
Место - можно выставить место в котором планируется выполнение задачи.
Последние значения сохраняются в выпадающем меню. При помощи этого меню
можно добавлять, удалять либо редактировать пункты. Для этого нажмите на
пункт Управление местоположениями в конце меню.
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Весь день - задачи с данным параметром не имеют времени начала и конца,
они занимают целый день и отображаются в верхней части календаря. 
Особая - эксклюзивность задачи в течении установленного для задачи
времени. Другая задача не сможет быть добавлена на это же время.
Приоритет - изменение приоритета задачи.
Выполнение - позволяет выставить уровень завершенности задачи.
Категория - позволяет назначить категорию для задачи. 
Текст - здесь можно добавить дополнительную информацию о задаче. В случае
если поле Тема не заполнено,  вместо него используется текст заметок для
отображении на разметке различных календарных видов.

Ряд параметров, таких как Категория, Приоритет, Статус и
Выполнение, можно изменять используя контекстное меню выделенной
задачи, либо через меню Правка.

Напоминания

Напоминание включается выбором времени напоминания в выпадающем меню в
разделе Напомнить:

Напоминание может быть выставлено либо непосредственно на время события (0
минута), либо заранее.

Нажав кнопку Настройки можно также установить дополнительные параметры
напоминания:
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Диалог дополнительных настроек позволяет установить звуковое сопровождение
для напоминания, это может быть как Стандартный звук, так и Звук из файла
в формате *.wav или *.mp3.
В блоке Сообщение можно выставить Специальное сообщение для
напоминания.
Можно также назначить выполнение программы вместе с напоминанием, для
этого нужно указать путь к запускаемому файлу программы через кнопку Обзор
в блоке Запуск программы.

Повторение задачи

EssentialPIM позволяет создавать серии повторяющихся задач. Для включения
повторений требуется активировать соответствующий чекбокс - Повторять
каждые:

Можно установить ежедневное, еженедельное, либо ежемесячное повторение
задачи. Параметр Истекает позволяет установить дату окончания серии. Для
установки более сложного цикла повторений можно воспользоваться
дополнительными параметрами, нажав кнопку Настройки:
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Данный диалог позволяет установить более сложный цикл повторений.
Например, как показано на иллюстрации выше, можно повторять задачу каждый
второй вторник месяца.

Чтобы не перегружать базу данных при создании бессрочных задач, по
умолчанию создается ограниченное количество повторений (для
каждого периода оно разное).

5.4 Дела

5.4.1 Работа со списками дел

Модуль Дела является простым и удобным инструментом для создания списка
дел. EssentialPIM позволяет сортировать дела по различным признакам,
присваивать различные приоритеты и категории. Эти и другие функции дают
широкие возможности по управлению списком дел.

Добавление дела

Добавить дело в список можно несколькими способами. Самый простой способ
это нажать кнопку Добавить  на панели Действия слева, либо в меню
Действия.
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Дело также можно создать двойным щелчком мыши по пустой части рабочей
области. При использовании обоих способов отрывается окно редактирования
дела, в котором можно указать тему, время начала и конца, категорию и прочие
параметры. Более подробно параметры дела рассмотрены в теме Редактирование
дела.

Shift+Ctrl+O - глобальное сочетание для добавления нового дела
(работает даже когда окно программы не активно в данный момент)
Дело также можно добавить через меню Файл -> Новый -> Дело

5.4.2 Редактирование дела

Дела могут быть отредактированы в любой момент. Быстрое редактирование дел
возможно напрямую в рабочей области модуля Дела. Для этого надо выделить
необходимую ячейку в таблице и сделать одиночный левый клик мыши, после
чего можно ввести/отредактировать данные. В нижней части рабочей области
экрана можно напрямую редактировать заметки выделенного дела.

Для более детального редактирования, можно воспользоваться окном создания/
редактирования дела. Диалоговое окно открывается двойным кликом левой
кнопки мыши по делу.

Начало - время начала дела (может быть не заполнено).
Конец - время окончания дела (может быть не заполнено).
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Тема - название дела.
Место - можно выставить место в котором планируется выполнение дела.
Последние значения сохраняются в выпадающем меню. При помощи этого меню
можно добавлять, удалять либо редактировать пункты. Для этого нажмите на
пункт Управление местами в конце меню.

Категория - позволяет назначить категорию для дела. 
Приоритет - позволяет изменить приоритет.
Выполнение - позволяет выставить уровень завершенности.
Текст - в этой закладке можно добавить дополнительную информацию о деле. В
случае когда поле Тема не заполнено, вместо него используется текст этой
вкладки.

Ряд параметров, таких как Категория, Приоритет, Статус и
Выполнение, можно изменять используя контекстное меню
выделенного дела, либо через меню Правка.

Напоминания

Напоминание включается соответствующим чекбоксом в блоке Напомнить:

Напоминание для дела выставляется на конкретное число и время.

Нажав кнопку Настройки можно также установить дополнительные параметры
напоминания:
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Диалог дополнительных настроек позволяет установить звуковое сопровождение
для напоминания, это может быть как Стандартный звук, так и Звук из файла
в формате *.wav или *.mp3.
В блоке Сообщение можно выставить Специальное сообщение для
напоминания.
Можно также назначить выполнение программы вместе с напоминанием, для
этого нужно указать путь к запускаемому файлу программы через кнопку Обзор
в блоке Запуск программы.

5.4.3 Анализ дел

При работе с проектами неизбежно возникает необходимость отслеживания
выполнения текущих дел. EssentialPIM предлагает удобный инструментарий для
решения данной задачи.

Сортировка дел

Важным инструментом анализа дел является возможность поиска и сортировки
дел по различным критериям. 

Для сортировки дел по колонкам надо щелкнуть левой кнопкой мыши по
заголовку столбца по которому требуется провести сортировку. В результате
чего дела будут отсортированы по возрастанию, при этом у заголовка столбца
появится значок стрелочки, которая показывает порядок сортировки. Второй
щелчок меняет порядок сортировки на противоположный. Для сортировки по
нескольким столбцам при щелчке на названия столбцов следует удерживать
клавишу Ctrl.

Для поиска либо фильтрации дел по одному ключевому слову, можно
воспользоваться строкой поиска в правом верхнем углу окна.
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Нажав на значок лупы, можно указать поле, по которому следует провести
поиск.

Поле поиска позволяет использовать операторы AMD / OR (и/или) для
более сложных запросов. Операторы должны быть написаны заглавными
английскими буквами.

Следует иметь в виду, что все рассмотренные приемы сортировки и
поиска могут быть использованы одновременно, дополняя друг друга.

5.5 Заметки

5.5.1 Работа с заметками

Модуль Заметки представляет собой удобный инструмент для хранения и
ведения ежедневных записей. Инструментарий модуля предлагает знакомый и
интуитивно понятный набор функций текстового редактора, так же позволяет
организовать заметки в иерархическую структуру. Эти и ряд других функций,
делают модуль Заметки мощным дополнением для управления ежедневным
потоком информации.

Добавление заметки

Добавить заметку можно несколькими способами. Самый простой способ - это
нажать кнопку Добавить в корень на панели инструментов, это добавит
заметку в корень активного в данный момент дерева заметок.

Чтобы создать Дочернюю, либо  Одноуровневую заметку, нажмите на кнопку
со стрелкой рядом с кнопкой Добавить в корень и выберите соответствующий
пункт. 
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В первом случае будет создана дочерняя заметка по отношению к выделенной, а
во втором - заметка будет добавлена на тот же уровень, что и выделенная в
данный момент. Новую заметку можно также создать через меню Действия ->
Новая заметка.

При этом откроется диалог, в котором можно указать основные параметры
заметки:

Имя - название создаваемой заметки. Если в это поле ничего не ввести то в
качестве имени будет взято первое предложение заметки.
Вставить - позволяет вставлять в имя заметки текущую дату. Дата и время
берутся из системных настроек.
Выбрать иконку - позволяет присвоить заметке иконку. Диалог выбора иконок
позволяет добавлять иконки из внешних файлов.

После введения всех необходимых параметров, можно нажать кнопку ОК, в
результате чего будет создана заметка размещенная в корневом списке
активного в данный момент дерева заметок.

Ctrl+R - горячее сочетание для добавления новой заметки
Shift+Ctrl+N - глобальное сочетание для добавления новой заметки
(работает даже когда окно программы не активно в данный момент)
Заметку также можно добавить через меню Файл -> Новый ->
Заметка

Перемещение по списку заметок

Модуль заметок содержит панель навигации.
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Данная панель показывает путь к выделенной в данный момент заметке. Клик на
имя заметки в пути переключает фокус на соответствующую заметку. Кнопки о
стрелками позволяют перемещаться между последними открытыми заметками.

Управление структурой заметок

Для удобства и наглядности хранимой информации, EssentialPIM поддерживает
организацию заметок в древовидную структуру. Чтобы создать новую дочернюю
заметку относительного текущей, нужно выделить родительскую заметку и
нажать кнопку Дочернее на панели Действия слева. В случае, когда
создаваемая заметка должна попасть на тот же уровень, надо воспользоваться
кнопкой На тот же уровень.

Структура уже созданного дерева заметок может быть с легкостью
отредактирована. Самый простой способ - это перетащить заметку, удерживая
левую кнопку мыши, на требуемую позицию. Во время перетаскивания курсор
будет подсвечивать на какую позицию попадёт заметка. Чтобы сделать заметку
дочерней, нужно перетащить её на название будущей родительской заметки,
как только родительская заметка станет подсвеченной, можно отпустить левую
кнопку мыши.

Перемещать дела можно также используя соответствующие кнопки на панели
инструментов.

Кнопки со стрелками перемещают выделенную заметку в соответствующем
направлении.

Чтобы быстро свернуть, либо развернуть все ветки заметок, можно
воспользоваться соответствующими кнопками на панели инструментов - 
Свернуть/Развернуть все.

Если перемещаемая заметка имеет дочерние заметки, то она будет
перемещена вместе со всей структурой подчинённых заметок.
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Ins - вставка дочерней заметки относительно текущей выделенной
Ctrl+G - вставка новой заметки на тот же уровень.

5.6 Контакты

5.6.1 Работа с контактами

Модуль Контакты - это удобный инструмент для хранения и управления
контактами. 

Добавление контакта

Добавить контакт можно несколькими способами. Самый быстрый это нажать
кнопку Добавить контакт на панели инструментов. Либо через меню Действия
-> Новый контакт.

Контакт также можно создать двойным щелчком мыши по пустой части рабочей
области экрана. При использовании обоих способов открывается окно
редактирования контакта, в котором можно указать имя, фамилию, адрес,
телефон прочие данные. Более подробно параметры контакта рассмотрены в
теме Редактирование контакта.

Ins - горячая клавиша для добавления нового контакта
Shift+Ctrl+C - глобальное сочетание клавиш для добавления нового
контакта (работает даже когда окно программы не активно в данный
момент)
Контакт также можно добавить через меню Файл -> Новый -> Контакт

Сортировка, поиск контактов

EssentialPIM предлагает ряд инструментов для удобной и быстрой навигации по
списку контактов, которые позволяют найти необходимую запись в несколько
кликов. 

Первое, чем можно воспользоваться - это строка поиска в правом верхнем углу
окна.
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Нажав на значок лупы, можно указать поле по которому следует провести
поиск. 

Следующее чем можно воспользоваться - это сортировка контактов по
столбцам. Для этого надо щелкнуть левой кнопкой мыши по заголовку столбца
по которому требуется провести сортировку. В результате чего контакты будут
отсортированы по возрастанию, при этом у заголовка столбца появится значок
стрелочки, которая показывает порядок сортировки. Второй щелчок меняет
порядок сортировки на противоположный. Для сортировки по нескольким
столбцам, необходимо при клике на названия столбцов удерживать клавишу
Ctrl.

Для быстрой навигации по списку контактов можно воспользоваться
алфавитным указателем в правой части рабочей области модуля Контакты.
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При нажатии на букву указателя, EssentialPIM переместит курсор на первый
контакт начинающийся с этой буквы. В качестве ключевого поля принимается
то, по которому контакты отсортированы на текущий момент. Алфавитный
указатель может содержать несколько языков. Чтобы настроить отображаемые
алфавиты, нужно нажать на кнопку в нижней части панели и выбрать
необходимые языки.

Поле поиска позволяет использовать операторы AMD / OR (и/или) для
более сложных запросов. Операторы должны быть написаны заглавными
английскими буквами.

Алфавитный указатель может быть включен, либо отключен через
меню Вид -> Индекс.

Следует иметь в виду, что все рассмотренные приемы сортировки и
поиска могут быть использованы одновременно, дополняя друг друга.

5.6.2 Редактирование контакта

Редактирование контакта может быть осуществлено несколькими способами.
Список контактов представлен в виде таблицы, поэтому самый простой способ
внесения изменений в уже созданные контакты - это редактирование их прямо в
рабочей области модуля, редактируя ячейки таблицы. Поля, отображаемые в
таблице, легко могут быть настроены под нужды пользователя. Для этого нужно
правым щелчком мыши по заголовку таблицы вызвать контекстное меню и
выбрать необходимые поля.

Порядок полей может быть изменен, для этого надо перетащить заголовки
таблицы на нужные позиции удерживая левую кнопку мыши.

Режимы отображения контактов
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Чтобы получить доступ ко всем полям контакта, следует открыть окно
редактирования контакта двойным щелчком левой  кнопки мыши, либо нажав
кнопку Изменить на панели инструментов.

Есть два режима отображения данных  контакте. Один группирует поля контакта
по тематическим разделам, он находится во вкладке Контакт. Второй
представляет список полей в более компактной общей таблице и находится во
вкладке Все поля. Ниже представлен обзор обоих режимов.

Вкладка Контакт (по умолчанию):

Данный диалог позволяет изменить любые данные о контакте. Для удобства
пользователя данные разделены на вкладки. Основные поля, которые могут
отображаться в рабочей области модуля, находятся во вкладках Личные
данные и Рабочие данные. 
Вкладка Заметки представляет собой небольшой текстовый редактор. Здесь
удобно хранить дополнительную информацию о контакте которая не помещается
в обычные поля.
Вкладка Рисунок позволяет добавить фотографию контакта, которая будет
отображаться в этой же вкладке, а также синхронизироваться с Android и iOS.
Поддерживаются следующие форматы: *.png, *.jpeg, *.jpg, *.bmp, *.ico).

Вкладка Все поля:
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1. Инструменты управления полями, позволяющие создавать новые и
редактировать формат имеющихся полей.
2. Область со всеми данными о контакте. Здесь содержатся как стандартные
поля, такие как имя, фамилия, телефон, адрес и пр., так и пользовательские.
3. Область заметок представляет собой простой текстовый редактор.

Доступ ко всем полям можно также получить и в рабочей области модуля
контактов, не открывая диалога редактирования. Для этого можно
воспользоваться панелью предпросмотра в нижней части рабочей обрасти
модуля.

Настройка полей

Практически все поля в модуле Контакты являются редактируемыми. Для того
чтобы изменить названия и свойства полей, необходимо открыть диалог
редактирования любого контакта и воспользоваться кнопками редактирования
полей в верхней части окна либо. Для быстрого добавления поля можно
воспользоваться кнопкой Добавить в любом из разделов.
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Добавить поле - создает новое поле. При создании поля можно указать его имя
и тип данных, после чего поле будет автоматически помещено в
соответствующий раздел.
Изменить поле - позволяет изменить названия и формат любого поля.
Добавить - добавляет поле в раздел.

Поля в модуле Контакты могут содержать разные типы данных, такие как:
текст, дата и время, выпадающее меню и ряд других. Поэтому, при добавлении
нового поля, вы видите диалог, в котором можно установить эти параметры.

Текст - обычное поле для ввода текстовых данных в одну строку, не имеет
дополнительных настроек.
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Телефон - данный формат определяет содержимое поля как телефонный номер.
При наличии модема данное поле позволяет набирать телефонный номер
напрямую из программы. При синхронизации с мобильными устройствами и
интернет сервисами это поле также переносится как телефонный номер.

Адрес - данное поле содержит дополнительные подчиненные поля для хранения
строк адреса.

Дата - поле, в которое можно ввести дату воспользовавшись календарем. Поле
с форматом Дата может быть использовано для автоматического создания
ежегодного события в календаре (дни рождения, праздники, годовщины). 

Показывать как задачу в категории - включает/отключает автоматическое
создание ежегодного события в календаре. Выпадающее меню позволяет
выбрать категорию для создаваемой серии задач.
Показывать внизу на экране Календаря - включает/отключает строку с
уведомлением о предстоящем ежегодном событии в нижней части рабочей
области Календаря. По умолчанию уведомление появляется за 3 дня до
наступления события.

Следует иметь в виду, что все изменения в структуре полей
применяются ко всем контактам в базе, не зависимо от того в каком
контакте или группе было сделано изменение.

Поля Имя, Фамилия и Место работы не могут быть удалены, так как
являются ключевыми и используются в синхронизациях. 

5.7 Почта

5.7.1 Создание почтового ящика

EssentialPIM включает в себя полноценный почтовый клиент, с классическим
набором инструментов, с поддержкой как IMAP так и POP3 протоколов, почтовых
фильтров и не ограниченного количества учетных записей.

Добавление учетной записи
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Прежде чем начать работу с почтой, необходимо создать новую учетную запись.
Сделать это можно через меню Файл -> Новый -> Почтовый ящик, либо,
находясь в модуле Почта через меню Сервис -> Почтовые ящики ->
Добавить. В обоих случаях это вызывает мастер создания учетной записи
почты.

На первом шаге предлагается заполнить поля Имя и Адрес e-mail - значения
именно этих полей получатель будет видеть в поле "От кого" при получении
писем. 

На втором и третьем шаге необходимо ввести параметры серверов входящей и
исходящей почты, соответственно. Для входящей почты доступно два типа
серверов IMAP4 и POP3. Для большинства известных почтовых сервисов,
параметры серверов заполнятся автоматически. Однако, если вы не уверены в
правильности заполнения параметров, обратитесь в раздел помощи вашего
почтового провайдера. Как правило, список параметров для почтовых серверов
находится в разделе часто задаваемых вопросов (ЧАВО или FAQ).

http://ru.wikipedia.org/wiki/IMAP
http://ru.wikipedia.org/wiki/POP3
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На последнем шаге, в случае использования POP3 почтового аккаунта,
предлагается создать глобальные папки (рис. слева). Эта функция может быть
полезной когда используется большое количество ящиков, при этом
используется один набор папок для всех учетных записей. Для учетных записей
использующих IMAP, функция глобальных папок не доступна (рис. справа).

Тип сервера входящей почты указывается на этапе создания почтового
ящика. Изменить тип сервера для уже созданных ящиков нельзя.

Параметр Использовать Глобальные папки можно присвоить только
при создании почтового ящика. Нельзя отключить, либо включить
данный параметр для уже созданного ящика.

Настройки учетной записи почты всегда можно откорректировать через
меню Сервис -> Почтовые ящики ->  Изменить.

5.7.2 Работа с почтой

Как только были созданы почтовые учетные записи, можно приступать к работе
с почтой.

Получение почты

Самым простым и быстрым способом получения почты, является запуск проверки
всех почтовых ящиков (если их несколько). Чтобы проверить все почтовые
ящики, достаточно нажать кнопку Получить/Отправить на панели действий
слева. Если  требуется проверить почту только в одном конкретном ящике, то
это можно сделать через меню Сервис -> Получить. В обоих случаях будет
вызвано диалоговое окно статуса отправки и получения почты.
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Данный диалог показывает состояние процесса отправки/получения почты. Если
в процессе возникнут какие-либо неполадки, то именно в этом окне в столбце
статус будет показано сообщение об ошибке. Наиболее часто встречающиеся
ошибки рассмотрены тут. 

Данный диалог также позволяет остановить процесс проверки почты как для
одного ящика (для этого надо выделить необходимую учетную запись и нажать 
Прервать), так и для всех учетных записей сразу, нажав кнопку Прекратить
все.

Ctrl+Alt+A - получить и отправить всю почту.
Ctrl+Alt+R - получить всю почту.

Создание и отправка писем 

При помощи EssentialPIM вы можете:

- Создать новое письмо. Для создания нового письма нужно нажать кнопку
Новое письмо на панели действий, либо через меню Действия -> Новое
письмо. 
- Ответить на полученное сообщение. Чтобы ответить на полученное письмо,
необходимо выделить сообщение  и нажать кнопку Ответить, либо Ответить
всем. При этом текст исходного сообщения будет помещен в тело письма в
качестве цитаты, а в поле получателя будет автоматически поставлен адрес
отправителя исходного письма. В случае ответа всем, копия письма будет
отправлена всем получателям исходного письма, их адреса будут прописаны в
поле Копия. Данная функция может быть полезной, когда переписка ведется
между группой лиц и требуется чтобы все участники переписки были в курсе
всех сообщений.
- Переслать сообщение. Чтобы переслать полученное сообщение другому
адресату, нужно выделить необходимое письмо и нажать на кнопку Переслать.
При этом исходное сообщение будет вставлено в тело письма без каких либо
изменений текста и форматирования, останется только добавить новый адрес
получателя.



Работа с EssentialPIM 43

© 2019 Astonsoft Ltd.

В результате всех перечисленных случаев, будет открыто окно создания/ответа
на письмо.

Данное окно предоставляет собой стандартный набор инструментов для
создания и редактирования писем. Поддерживается как расширенный (HTML),
так и простой текстовый формат для текста внутри сообщения. Переключение
между форматами осуществляется через меню Формат.

Поле От Кого содержит список персоналий от всех установленных почтовых
ящиков. При изменении отправителя автоматически меняется подпись
ассоциированная с данным отправителем.
Нажав на кнопки Кому, Копия или Скрытая можно добавить адреса
получателей в соответствующие поля с помощью дополнительного окна.



EssentialPIM Free файл помощи44

© 2019 Astonsoft Ltd.

Список слева показывает доступные контакты с адресами в базе, справа -
получатели в соответствующих полях. Чтобы добавить или удалить адресатов из
списков, нужно выделить контакт(ы) и нажать соответствующую кнопку со
стрелкой. Чтобы облегчить поиск необходимых контактов, можно
воспользоваться выпадающим меню Фильтр и полем Поиск. Меню Фильтр
позволяет показать контакты только из определенных групп.

Окно редактирования письма также содержит вкладку Вложения, которая
позволяет прикреплять файлы к письму. 

Как только письмо готово, его можно немедленно отправить, нажав кнопку 
Отправить. Если работа над сообщением не закончена, его можно сохранить в
папку Черновики и продолжить работу над ним позже. Это можно сделать через
меню Файл -> Сохранить, либо просто закрыть окно редактирования письма и
подтвердить запрос на сохранение в черновики.

Десять последних значений поля Тема в письмах сохраняются в базе данных для
последующего использования. Ранее использованные темы можно выбрать из
выпадающего меню.
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Список сохраненных тем можно редактировать, для этого в выпадающем списке
надо выбрать пункт Управление темами. Это откроет диалоговое окно, где
можно редактировать список. В этом же окне можно "прикреплять" темы путём
выставления галочки в колонке Pinned, чтобы они всегда были в списке и не
уходили из него со временем, после появления новых тем.

Опция Не сохранять темы автоматически, отключает автоматическое
добавление новых пунктов в список.

К письму можно добавить запрос на подтверждение о получении, это
можно сделать через меню Настройки -> Подтверждение получения.

Ctrl+M - отправить письмо
Ctrl+S - сохранить письмо в черновик

Настройки почты

Общие настройки почты доступны через меню Сервис -> Настройки -> Почта.
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Отправлять письма немедленно - если функция включена, то при нажатии
кнопки Отправить, в окне создания письма, письмо помещается в папку
Исходящие и отправляется немедленно. Если опция отключена, то письмо
помещается в папку Исходящие и ждет ручной отправки.
Отсылать неотправленные при выходе - отправляет все письма из папки
Исходящие при выходе из программы. Данная функция может быть полезна если
параметр Отправлять письма немедленно отключен.
Проверять при запуске, что EssentialPIM является почтовой программой
по умолчанию - данная функция должна быт всегда включена, если требуется
чтобы EssentialPIM всегда оставался почтовым клиентом по умолчанию.
Проверка отсутствия вложений - в момент отправки письма напоминает о
том, что вы забыли добавить вложенный файл, если в тексте встречаются
определенные ключевые слова. Список ключевых слов можно настроить нажав
на кнопку Ключевые слова.

Портативная версия EssentialPIM не может быть установлена клиентом
по умолчанию.

5.7.3 Виды просмотра, сортировка, фильтрация

Виды просмотра почты

Модуль почты может отображаться в трех видах: классическом
(горизонтальном), вертикальном и широком (вариация классического вида).
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Установить данный параметр можно в меню Вид -> Вид.

Изображения в предпросмотре

В целях безопасности окно предпросмотра не загружает рисунки из Интернета
по умолчанию.

Чтобы загрузить рисунки, кликните желтую линию вверху письма и выбирите
необходимый вариант загрузки.

Действия с адресами От Кого/Кому
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При клике на любой адрес в заголовочной части письма открывается меню, с
помощью которого можно добавить адрес в список контактов, отредактировать,
скопировать или создать правило.

Настройка основного вида

EssentalPIM Pro позволяет настроить набор отображаемых столбцов в рабочей
области модуля Почта.

Кликните правой кнопкой мыши по заголовку таблицы, чтобы вызвать меню в
котором можно включить/отключить столбцы.

Если требуется изменить порядок колонок, то их можно перетащить на нужные
позиции удерживая левой кнопкой мыши. Иконка со стрелочкой показывает куда
будет помещена перетаскиваемая колонка.

EssentalPIM Pro запоминает настройки колонок для каждой папки в почте. Для
быстрого копирования настроек в другие папки можно воспользоваться пунктом
меню Применить к....

Сортировка и фильтрация

Самый простой способ - это сортировка писем по колонкам. Для этого надо
щелкнуть левой кнопкой мыши по заголовку столбца по которому требуется
провести сортировку. В результате чего письма будут отсортированы по
возрастанию, при этом у заголовка столбца появится значок стрелочки, которая
показывает порядок сортировки. Второй щелчок меняет порядок сортировки на
противоположный. Для сортировки по нескольким столбцам при щелчке на
названия столбцов следует удерживать клавишу Ctrl.

Для поиска либо фильтрации писем по одному ключевому слову, можно
воспользоваться строкой поиска в правом верхнем углу окна.
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Нажав на значок лупы, можно указать поле, по которому следует провести
поиск.

Для фильтрации писем сразу по нескольким столбцам и критериям, EssentialPIM
предлагает воспользоваться режимом фильтра. Чтобы перейти в этот режим,
нажмите кнопку Фильтр на панели инструментов, в результате чего у заголовка
каждого столбца появится выпадающее окошко фильтра.

Данное окно содержит все значения, встречающиеся в текущем столбце.
Галочками можно отметить значения, которые требуется отобразить в списке.
Если значений очень много, то можно воспользоваться строкой поиска в верхней
части окна. Как только все значения отмечены, можно нажать кнопку ОК для
применения фильтра. Щелчок мыши за пределами окна равносилен нажатию
кнопки Отмена.

В почте также имеется панель быстрого фильтра:
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C помощью него можно быстро отобразить только непрочитанные письма,
помеченные звездой, письма с вложениями, либо письма от корреспондентов из
вашего списка контактов.

Если применен какой-либо фильтр, то в верхней части окна появится панель 
Индивидуального вида, которая показывает какие типы фильтров применены в
данный момент. Чтобы удалить какой-либо из фильтров, надо кликнуть по нему
курсором и выбрать команду Показать.

Поле поиска позволяет использовать операторы AMD / OR (и/или) для
более сложных запросов. Операторы должны быть написаны заглавными
английскими буквами.

Следует иметь в виду, что все рассмотренные приемы сортировки и
фильтрации могут быть использованы одновременно, дополняя друг
друга.

5.7.4 Настройка почтовых ящиков

Параметры установленных почтовых ящиков могут быть изменены через меню 
Сервис -> Почтовые ящики.

Данный диалог представляет список установленных почтовых ящиков и
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предлагает ряд настроек:

Добавить - создает новый почтовый ящик при помощи мастера создания новой
учетной записи. 
Изменить - открывает диалог настройки почтового ящика, ниже он рассмотрен
более подробно.
Удалить - удаляет почтовый ящик вместе со всеми письмами. 
По умолчанию - позволяет присвоить это свойство одному из почтовых
ящиков. Именно этот ящик будет использоваться при создании новых писем не
из модуля почты. Например, при создании письма из модуля Сегодня или при
клике на адрес электронной почты в EssentialPIM, браузере и ряде других
программ. 
Вверх/Вниз - меняет порядок отображения ящиков в главном окне модуля.

Итак, нажав кнопку Изменить, будет вызван диалог настройки почтового ящика,
состоящего из четырех вкладок.

Вкладка Общие содержит данные об учетной записи и отправителе. Именно эти
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данные получатель увидит в графе "От кого" пришедшего письма. Каждая
учетная запись может содержать несколько наборов идентификационных
данных. Их можно добавить в разделе Персоналии. Данные раздела персоналий
всех почтовых ящиков отображаются в поле От Кого в окне редактирования
письма.

При нажатии на кнопку Изменить, открывается окно редактирования
Персоналии. 

Данное окно позволяет заполнить данные которые будет видеть получатель, а
также позволяет включить автоматический Запрос уведомления о
прочтении... Данные параметры будут использованы при отправке письма с
использованием этой Персоналии.
Выпадающий список в пункте Сервер исходящей почты позволяет уточнить,
какой SMTP сервер использовать при указании данной персоналии.
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Вкладка Серверы содержит адреса и параметры серверов входящей и
исходящей почты. При использовании большинства известных почтовых
серверов, EssentialPIM автоматически заполняет эти поля на этапе создания
почтового ящика. Для более редких, либо частных случаев,  параметры
требуется откорректировать вручную. Если вы не уверены в правильности
параметров серверов, обратитесь в раздел помощи вашего почтового
провайдера. Как правило, параметры серверов находятся в разделе часто
задаваемых вопросов (ЧАВО или FAQ).
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Вкладка Настройки позволяет установить ряд параметров для автоматизации
работы с почтой. Набор опций несколько различен для учетных записей POP3
(слева) и IMAP4 (справа), что объясняется спецификой работы данных
протоколов.
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Вкладка Подпись позволяет создать подпись, которая будет автоматически
добавляться к новым письмам. Для каждого почтового ящика или для каждой
отдельной персоналии можно создавать отдельную подпись.

5.7.5 Спам фильтр

Почтовый модуль EssentialPIM содержит адаптивный спам фильтр. Он обучается
определять нежелательную почту в соответствии с действиями пользователя.

Для эффективного использования данного инструмента потребуется некоторое
время для его обучения. Для этого надо помечать нежелательную почту при
помощи кнопки Отметить как Спам на панели инструментов. В равной степени
важно отмечать письма, ошибочно определенные как спам, при помощи кнопки 
Отметить как Не спам. Данная кнопка появляется на панели инструментов
когда выбрана папка Спам. Со временем, чем больше писем будем помечено как
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спам или не спам, тем эффективней будет работать фильтр.

Спам фильтр выключен по умолчанию и может быть отдельно включен или
отключен для каждого почтового ящика. Сделать это можно во вкладке 
Настройки Спама в диалоге настроек учетной записи почты.

Дополнительные параметры можно установить в общих настройках спам
фильтра. Для этого нажмите на кнопку  Общие настройки в закладке
Настроек Спама, либо проследуйте в меню Сервис -> Настройки -> Спам.

Данный диалог позволяет установить как поступать со спамом во всех почтовых
ящиках.

5.7.6 Решение проблем с почтой

1. Socket Error 
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Данная ошибка возникает в том случае, когда EssentialPIM не может
соединиться с почтовым сервером. В большинстве случаев причиной являются
неправильные адреса серверов входящей либо исходящей почты. Более редкой
причиной является блокировка программы брандмауэром.

Пути решения:
1. Откройте настройки серверов через Сервис -> Почтовые ящики ->
Изменить -> Серверы, затем исправьте необходимые параметры. В случае,
если вы не в курсе, что именно надо исправить, зайдите в ваш почтовый ящик
через веб-интерфейс и обратитесь к разделу помощи вашего почтового
провайдера. Вам надо найти настройки POP3/IMAP4 (для входящей почты) и
SMTP (для исходящей почты) серверов.

2. Добавьте EssentialPIM в исключения в настройках межсетевого экрана.

5.8 Пароли

5.8.1 Работа с паролями

Модуль Пароли представляет собой хранилище и менеджер данных учетных
записей для различных сервисов. Инструментарий модуля позволяет хранить
детали учетных записей, генерировать пароли.

Добавление записи

Новый пароль может быть добавлен несколькими способами. Самый быстрый -
это нажать кнопку Добавить запись на панели Действия в левой части
экрана. Либо через меню Действия -> Новая запись Паролей.

Пароль также можно создать двойным щелчком мыши по пустой части рабочей
области модуля Пароли. При использовании обоих способов, открывается окно
редактирования записи пароля, в котором можно указать логин, пароль, адрес
сервиса и прочие данные. Более подробно параметры записи рассмотрены в
теме Редактирование паролей.
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Ins - горячая клавиша для добавления новой записи пароля.
Shift+Ctrl+Р - глобальное сочетание клавиш для добавления новой
записи (работает даже когда окно программы не активно в данный
момент)
Пароль также можно добавить через меню Файл -> Новый -> Запись
Паролей

Использование паролей

Чтобы воспользоваться учетными данными из модуля Пароли, достаточно
скопировать логин/пароль в буфер обмена, затем вставить в соответствующие
поля. Для ускорения процедуры достаточно сделать двойной клик левой
кнопкой мыши по необходимому полю в рабочей области модуля, либо по
названию поля в нижней части экрана, после чего значение поля будет
скопировано в буфер обмена.

5.8.2 Редактирование паролей

Записи паролей могут быть отредактированы в любой момент. Быстрое
редактирование возможно напрямую в рабочей области модуля Пароли. Список
записей представлен в виде таблицы, для редактирования данных нужно
выделить необходимую ячейку и сделать одиночный левый клик мыши, после
чего можно ввести/отредактировать данные. В нижней части рабочей области
можно напрямую редактировать данные выделенной записи.

Для более детального редактирования записей, можно воспользоваться окном
редактирования пароля. Диалоговое окно редактирования данных пароля
открывается двойным кликом левой кнопки мыши.
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1. Кнопка добавления дополнительного поля.
2. Основные данные о записи, такие как логин, пароль, название и адрес
ресурса, а также дополнительные пользовательские данные.
3. Область заметок представляет собой простое текстовое поле.

Для создания уникального пароля можно воспользоваться генератором паролей,
нажав на кнопку Ген. При этом будет вызван диалог генерации пароля.
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Здесь можно задать какие символы будут использоваться при создании пароля и
его длину.

Настройка полей

EssentialPIM позволяет добавлять и редактировать поля в модуле Пароли. Для
того, чтобы внести изменения в структуру полей, нужно открыть диалог
редактирования любого пароля и воспользоваться следующими инструментами.
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Следует иметь в виду, что все изменения в структуре полей
применяются ко всем записям паролей в базе, не зависимо от того для
какой записи было сделано изменение.

5.9 Печать

EssentialPIM позволяет выводить информацию на печать в удобной для
последующего прочтения форме. По умолчанию на печать выводится тот модуль
и тот вид, которые отображаются на экране в данный момент. Для вывода
данных на печать, зайдите в меню Файл -> Печать с просмотром. Чтобы
изменить параметры печати зайдите в меню Файл -> Печать. Каждый модуль
имеет разные параметры печати. Ниже рассмотрено, какие параметры доступны
для каждого из модулей.

Сегодня

Модуль Сегодня выводится на печать в том же виде как и представлен на
экране.

Календарь

Существует несколько вариантов печати календаря: по дням, неделям, месяцам
и в табличном виде. В разделе Диапазон печати можно указать диапазон дат.

Дела

Для диапазона печати можно выбрать все отображаемые в данный момент дела,
либо только выделенный набор дел.  В области Параметров печати можно
можно включить/отключить печать пустых полей, а нажав кнопку Поля можно
указать какие поля будут выведены на печать.

Заметки 

На печать можно вывести весь список заметок, только выделенные заметки,
либо только выделенную часть текста заметки. Перечисленные опции можно
выбрать в области Диапазон печати. 

Контакты

Контакты можно напечатать таблицей, либо в виде карточек. Для диапазона
печати могут быть выбраны все контакты отображаемые в данный момент в
модуле Контакты, либо только выделенные. В области Параметров печати
можно можно установить какие поля выводить на печать, нажав кнопку Поля.
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Пароли

При печати паролей, также можно вывести на печать все, либо выделенные
пароли и указать поля для печати.

Для быстрого вывода на печать любой записи в базе данных, можно
воспользоваться командой Быстрая печать из контекстного меню по
правой кнопке мышки.

5.10 Импорт/Экспорт данных

5.10.1 Импорт

В общем виде все данные импортируются в EssentialPIM через меню Файл ->
Импорт -> "Модуль" -> "Тип данных". В данном разделе представлено
описание форматов данных, поддерживаемых при импорте. 

Календарь

- iCal формат. Календарь может быть импортирован из календаря iCal (*.ics). Это
распространенный формат множества различных онлайн сервисов и программ.
Этот формат удобно использовать для импорта праздников, загрузив из
Интернета соответствующий файл календаря. Диалог импорта позволяет
указывать путь как к файлам, расположенным в Интернете, так и к локальным
*.ics файлам. 
- CSV, импортирует события из *.csv файла. Данный формат является
стандартным для широкого круга приложений. Более подробно о процессе
импорта можно прочитать тут.
- EPIM, файл базы данных EssentialPIM (*.epim). 

Импортировать iCal календари можно путем перетаскивания iCal (*.ics)
файла в окно календаря.

Дела 

- iCal формат. Списки дел могут быть импортированы из *.ics файла, аналогично
календарю. Также поддерживается импорт как из Интернета, так и из
локального файла.
- CSV, импортирует дела из *.csv файла. Данный формат является стандартным
для широкого круга приложений. Более подробно о процессе импорта можно
прочитать тут.
- EPIM, файл базы данных EssentialPIM (*.epim). 

Заметки

- RTF/TXT, файлы *.rtf и *.txt импортируются в одну заметку, все данные
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помещаются на один лист.
- TreePad, импорт из программы TreePad, с сохранением иерархической
структуры заметок.
- KeyNote, импорт из программы KeyNote, с сохранением древовидной структуры
заметок.
- EPIM, файл базы данных EssentialPIM (*.epim). 

Контакты

- vCard импортирует контакты из *.vcf файлов. Контакты помещаются в группу,
которая была выбрана в момент импорта.
- CSV, импортирует контакты из *.csv файла. Данный формат является общим
для широкого круга приложений. Более подробно о процессе импорта можно
прочитать тут.
- EPIM, файл базы данных EssentialPIM (*.epim). 

Пароли

- CSV, процесс импорта паролей из *.csv файла анологичен импорту контактов,
описанному выше.
- Roboform HTML позволяет импортировать файлы в формате *.html, созданные
программой Roboform.
- KeyPass XML, позволяет импортировать файлы в формате *.xml созданные
программой KeyPass.
- CSV, импортирует пароли из *.csv файла. Данный формат является общим для
широкого круга приложений. Более подробно о процессе импорта можно
прочитать тут.
- EPIM, файл базы данных EssentialPIM (*.epim). 

Почта

- EML, импортирует письма из *.eml файлов. Импортированные письма
помещаются в выделенную на момент импорта папку.

Импорт из Outlook 

EssentialPIM поддерживает импорт данных из *.pst файлов MS Outlook. При
импорте можно указать какие модули подлежат импорту. Поддерживается также
импорт почты, при этом в диалоге импорта надо указать в какой почтовый ящик
EssentalPIM следует импортировать письма. Если опция импорта почты
неактивна, значит в EssentialPIM еще не создано ни одно почтового ящика.
Создайте ящик как это описано в теме Создание почтового ящика.

5.10.1.1 CSV Import

EssentialPIM позволяет импортровать записи календаря, дел и контактов из
файлов в формате CSV.

После выбора файла для импорта открывается следующее диалоговое окно.
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Главная задача данного диалога - согласование полей исходного файла с
полями контактов в EssentialPIM. В случае, когда заголовок таблицы содержит
названия столбцов в исходном файле, можно включить параметр "Первая строка
файла содержит названия столбцов" в верхней части окна, после чего
программа сама перераспределит поля в соответствующие поля EssentialPIM и
создаст необходимые дополнительные поля.

В случае, когда исходный файл не содержит заголовков, поля необходимо
назначить вручную. Для этого нужно выделить колонку с даннми исходного
файла и указать соответствующее ему поле из выпадающего списка Импорт в,
после чего заголовок изменится на соответствующее поле в EssentialPIM.

Немаловажным также является установка правильного символа разделителя. По
умолчанию EssentialPIM предлагает использовать символ ";", указанный в поле 
Разделитель, но формат CSV позволяет использовать различные символы в
качестве разделителя и в исходном файле он может быть другим. Это сразу
будет видно в окне импорта - все данные будут находится в одном столбце.
Чтобы таблица прочиталась корректно и колонки разделились, необходимо
сначала выяснить какой символ используется в исходном файле в качестве
разделителя. Это можно выяснить или открыв файл в блокноте Windows или
попробовав вводить наиболее часто встречающиеся символы в поле 
Разделитель (обычно это точка, запятая или двоеточие). EssentialPIM
автоматически разобьёт данные на колонки при указании правильного символа-
разделителя.

Как только все поля назначены можно нажать кнопку ОК, после чего контакты
будут импортированы.

5.10.2 Экспорт

EssentialPIM позволяет экспортировать данные в различные форматы, что
упрощает процесс переноса данных в сторонние программы или сервисы, когда
это необходимо. В общем виде экспорт данных доступен через меню Файл ->
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Экспорт -> "Название модуля" -> "Формат данных". Ниже рассмотрены
поддерживаемые форматы данных по каждому модулю.

Календарь

- HTML - экспортирует календарь в *.html файл, который можно открыть при
помощи браузера, либо выложить в Интернет. Диалог экспорта позволяет
указать диапазон дат и вид календаря (день, неделя, месяц). Нажав кнопку 
Категории, можно указать события каких категорий включать в экспортируемый
файл.
- iCal - экспортирует в *.ics файл, одни из наиболее часто используемых
форматов для календаря. Диалог экспорта позволяет экспортировать весь
календарь, текущий день/неделю/месяц/год, либо указать диапазон дат. Нажав
кнопку Категории, можно указать события каких категорий включать в
экспортируемый файл.
- EPIM, файл базы данных EssentialPIM (*.epim). 

Дела

- HTML - дела экспортируются в виде таблицы в *.html файл. Окно экспорта
позволяет экспортировать весь список имеющихся дел, только видимых в
данный момент в окне модуля (удобно при экспорте результатов выборки), либо
только выделенные дела. Кнопки Категории и Поля позволяют выбрать дела
каких категорий и какие поля в делах включать в экспорт.
- iCal - список дел экспортируется в *.ics файл. Параметры экспорта
аналогичны параметрам HTML, за исключением набора полей. В iCal
экспортируется только стандартный набор полей.
- EPIM, файл базы данных EssentialPIM (*.epim). 

Заметки

- HTML, RTF, DOCX - заметки экспортируются, соответственно, в *.html, *.rtf,
*.docx файлы. При экспорте сохраняется форматирование заметок. 
- TXT - экспорт в *.txt файл. Форматирование при этом теряется.
- EPIM, файл базы данных EssentialPIM (*.epim). 

Контакты

- CSV - контакты экспортируются в *.csv таблицу. Затем файл может быть
открыт в любом табличном процессоре. 
- HTML - контакты экспортируются в *.html файл в виде карточек контактов.
- RTF, TXT - контакты экспортируются в *.rtf и *.txt файлы. Контакты и группы
экспортируются списком.
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Экспортировать можно весь список, видимые, либо только выделенные
элементы. Нажав кнопку Поля, можно указать какие поля включать в экспорт.

- vCard - экспортирует контакты в *.vcf файлы. Для каждого контакта
создается отдельный файл. Экспортируются только поля, предусмотренные
vCard форматом.
- EPIM, файл базы данных EssentialPIM (*.epim). 

Пароли

- CSV - список паролей экспортируются в *.csv таблицу.
- EPIM, файл базы данных EssentialPIM (*.epim). 

Почта

- EML - письма экспортируются в *.eml файлы. Каждое письмо экспортируется в
отдельный файл.

Экспорт в Outlook

EssentialPIM Pro позволяет экспортировать данные в Outlook. Диалог экспорта
позволяет экспортировать модули Календарь, Дела, Заметки и Контакты. Для
календаря можно указать диапазон дат, подлежащий экспорту.

5.11 Синхронизации

5.11.1 Android

EssentialPIM поддерживает синхронизацию с устройствами, работающими на
Android. Для этого требуется установить Android версию EssentialPIM на телефон
или планшет. Последняя версия всегда доступна в Google Play Store.

Необходимые условия для синхронизации:

- Android 4.0.3 или выше
- Общая сеть между Android устройством и компьютером. Как правило, такая
сеть уже имеется если используется Wi-Fi маршрутизатор. Компьютер обычно
подключен к нему через кабель, в то время как мобильные устройства

https://play.google.com/store/apps/details?id=com.astonsoft.android.essentialpim&referrer=utm_source%3Depimwebsite%26utm_medium%3Dcpc
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подключаются через Wi-Fi. Возможно также подключение через Bluetooth, USB
кабель, либо сотовую связь.

Установка и запуск синхронизации

Настройка синхронизации осуществляется через меню Файл -> Синхронизация
-> Добавить синхронизацию -> Android.

Этап сопряжения устройств. Внимательно прочитайте инструкцию в данном
диалоге и убедитесь, что все условия выполнены. Затем запустите EssentialPIM
на мобильном устройстве и выберите СинхроПК.
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Приложение автоматически произведет поиск компьютеров с запущенной
Windows версией EssentialPIM. Если такой ПК будет найден, то на экране
появится его имя. Чтобы начать синхронизацию нажмите на имя ПК. Если
компьютер не определяется, то попробуйте ручное соединение. Для этого
вызовите программное меню и выберите пункт Ручное соединение, после чего
введите IP адрес и порт предлагаемые мастером в Windows версии. 

Чтобы предотвратить несанкционированные попытки синхронизации с другими
устройствами, Windows версия EssaentialPIM запросит разрешение
синхронизации с данным конкретным устройством во время первой попытки
соединения. 

На последнем шаге мастера можно изменить название синхронизации, а также
выбрать ее  направление.
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Для запуска последующих синхронизаций необходимо:
- запустить Windows версию EssentialPIM 
- запустить Android версию EssenrialPIM, зайти в СинхроПК, а затем либо нажать
на имя компьютера (если устройства в одной сети), либо зайти в меню и
выбрать пункт Ручное соединение (если соединяетесь через сеть сотовой связи,
Bluetoth, или USB кабель)

Если вы планируете синхронизировать несколько Android устройств с
Windows версией EssentialPIM, то следует иметь в виду, что процедуру
установки синхронизации необходимо провести заново для каждого
нового устройства. 

Если соединиться не удалось, обратитесь к теме "Решение проблем".

5.11.1.1 Синхронизация через USB, Bluetooth, мобильные сети

Windows и Android версии EssentialPIM проще и быстрее всего синхронизировать
через Wi-Fi сеть. Тем ни менее, синхронизация может быть осуществлена при
помощи других способов подключения, таких как USB кабель, Bluetooth,  сети
сотовой связи и мобильной точкой доступа Wi-Fi.

Если по какой-то причине обычная Wi-Fi сеть недоступна, попробуйте
использовать один из вышеперечисленных способов. Далее рассмотрим каждый
из них подробнее.
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Синхронизация через USB кабель

1. Подключите Android устройство к ПК.
2. Зайдите в настройки телефона или планшета, затем выберите пункт Tethering
& portable hotspot (обычно он расположен в разделе Беспроводные сети) и
включите опцию USB Tethering.

3. На ПК нажмите Пуск, в командной строке введите cmd и нажмите ввод (для
пользователей Windows XP, нажмите Пуск, затем Выполнить, введите cmd и
нажмите ввод).
4. В появившемся окне введите ipconfig и нажмите ввод. Запомните или
запишите IP адрес (IPv4 Address) в разделе Ethernet adapter Local Area
Connection.
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5. Теперь запустите Windows версию EssentialPIM. Если вы синхронизировались
ранее, зайдите в меню Сервис -> Настройки, выберите синхронизацию с вашим
устройством в разделе Синхронизация. В поле IP должен отображаться IP адрес,
который вы записали.

Если это ваша первая синхронизация, тогда зайдите в меню Файл ->
Синхронизация -> Добавить Синхронизацию -> Android и следуйте шагам
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мастера до тех пор пока не дойдете до шага сопряжения устройств. Здесь вы
должны увидеть тот же IP адрес, что был отмечен ранее.

6. Вернитесь к EssentialPIM на Android и зайдите в раздел СинхроПК, затем
вызовите меню и нажмите пункт Ручное соединение.
7. Введите IP адрес и порт, указанные на предыдущем шаге и нажмите Connect.
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8. Синхронизация должна начаться.

Синхронизация через сети сотовой связи (3G, LTE)

В первую очередь вы должны узнать IP адрес вашего компьютера. Сделать это
можно следующим образом.

1. Воспользуйтесь поисковиком Google и введите запрос: "what's my ip".
2. Первым в списке результатов будет сайт под названием What Is My IP,
перейдите на него.
3. На странице будет написан ваш внешний IP адрес. Запишите его.

Если вы подключены к интернету через маршрутизатор, то надо зайти в его
настройки и установить переадресацию портов так, чтобы все внешние запросы
на TCP/UDP порт 21114 (порт по умолчанию а EssentialPIM), были бы направлены
на ваш ПК. Обратитесь к документации вашего маршрутизатора, чтобы узнать
как это делается, либо обратитесь в нашу службу поддержки за консультацией.

Следующим шагом убедитесь, что ваш брандмауэр позволяет Windows версии
EssentialPIM принимать входящий трафик из Интернета. Если вы используете
брандмауэр Windows, сделайте следующее:

1. Зайдите в меню Пуск -> Панель управления -> Брандмауэр Windows
2. Выберите пункт Разрешить запуск программы или компонентов через
брандмауэр Windows.
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3. Убедитесь, что для EssentialPIM поставлены галочки в обоих колонках.

Если вы используете другие фаерволы, то обратитесь к их документации.

Все приготовления закончены, теперь вернитесь в EssentialPIM на мобильном
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устройстве, нажмите СинхроПК, вызовите меню и выберите пункт Ручное
соединение. Введите внешний IP адрес вашего компьютера, который мы
определили ранее, измените порт (если необходимо) и нажмите Connect.

- Если вы синхронизировались ранее то убедитесь, что EssentialPIM запущен.
- Если вы синхронизируетесь первый раз, то зайдите в меню Файл ->
Синхронизация -> Добавить Синхронизацию -> Android и следуйте шагам
мастера до тех пор пока не дойдете до шага сопряжения устройств. На этом
этапе нажмите Connect в Android версии после ввода IP адреса.

Синхронизация через мобильную точку доступа Wi-Fi

При использовании этого варианта подключения, создается частная Wi-Fi сеть
между вашим компьютером и устройством на Android. В этом случае мобильное
устройство выступает в качестве маршрутизатора и компьютер подключается к
нему.

1. Зайдите в настройки телефона или планшета, затем выберите пункт Tethering
& portable hotspot (обычно он расположен в разделе Беспроводные сети) и
включите опцию Portable Wi-Fi hotspot (в некоторых случаях Android предложит
настроить точку доступа, следуйте предложенным инструкциям).

2. На компьютере найдите в списке доступных сетей вашу Wi-Fi сеть и
подключитесь. 
3. На ПК нажмите Пуск, в командной строке введите cmd и нажмите ввод (для
пользователей Windows XP, нажмите Пуск, затем Выполнить, введите cmd и
нажмите ввод).



EssentialPIM Free файл помощи76

© 2019 Astonsoft Ltd.

4. В появившемся окне введите ipconfig и нажмите ввод. Запомните или
запишите IP адрес (IPv4 Address) в разделе Wireless LAN adapter Wi-Fi.

5. Теперь запустите Windows версию EssentialPIM. Если вы синхронизировались
ранее, зайдите в меню Сервис -> Настройки, выберите синхронизацию с вашим
устройством в разделе Синхронизация. В поле IP должен отображаться IP адрес,
который вы записали.
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Если это ваша первая синхронизация, тогда зайдите в меню Файл ->
Синхронизация -> Добавить Синхронизацию -> Android и следуйте шагам
мастера до тех пор пока не дойдете до шага сопряжения устройств. Здесь вы
должны увидеть  тот же IP адрес, что был отмечен ранее.

6. Вернитесь к EssentialPIM на Android и зайдите в раздел СинхроПК, затем
вызовите меню и нажмите пункт Ручное соединение.
7. Введите IP адрес и порт, указанные на предыдущем шаге и нажмите Connect.
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8. Синхронизация должна начаться.

Синхронизация через Bluetooth

1. Зайдите в настройки телефона или планшета, затем выберите пункт Tethering
& portable hotspot (обычно он расположен в разделе Беспроводные сети) и
включите опцию Подключение по Bluetooth.
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2. Включите Bluetooth на компьютере и сделайте доступным ваше Android
устройство.
3. Зайдите в Пуск -> Панель управления -> Устройства и Принтеры.
Воспользовавшись кнопкой Добавление устройства, добавьте ваше мобильное
устройство и соедините с ПК.
4. Как только устройства соединены, выберите пункт Точка доступа в
контекстном меню. 
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5. На ПК нажмите Пуск, в командной строке введите cmd и нажмите ввод (для
пользователей Windows XP, нажмите Пуск, затем Выполнить, введите cmd и
нажмите ввод).
6. В появившемся окне введите ipconfig и нажмите ввод. Запомните или
запишите IP адрес (IPv4 Address) в разделе Ethernet adapter Bluetooth Network
Connection.

7. Теперь запустите Windows версию EssentialPIM. Если вы синхронизировались
ранее, зайдите в меню Сервис -> Настройки, выберите синхронизацию с вашим
устройством в разделе Синхронизация. В поле IP вы должен отображаться IP
адрес который вы записали.
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Если это ваша первая синхронизация, тогда зайдите в меню Файл ->
Синхронизация -> Добавить Синхронизацию -> Android и следуйте шагам
мастера до тех пор пока не дойдете до шага сопряжения устройств. Здесь вы
должны увидеть  тот же IP адрес, что был отмечен ранее.
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8. Вернитесь к EssentialPIM на Android и зайдите в раздел СинхроПК, затем
вызовите меню и нажмите пункт Ручное соединение.
9. Введите IP адрес и порт указанные на предыдущем шаге и нажмите Connect.

10. Синхронизация должна начаться.
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5.11.1.2 Решение проблем с Android синхронизацией

1. При попытке соединения Android с ПК возникает Ошибка соединения.

Причиной данной ошибки является неверно указанный IP адрес или порт, либо
EssentialPIM блокируется фаерволом.

Пути решения:

1. Убедитесь, что вы внимательно следовали инструкциям по настройке и
установке Android синхронизации.
2. Убедитесь, что вы используете последнюю Windows версию EssentialPIM.
Проверить наличие доступных обновлений можно через меню Справка ->
Проверить обновление.
3. Если это первая синхронизация, убедитесь что мастер установки
синхронизации в Windows версии EssentialPIM запущен и находится на шаге
сопряжения устройств. Если устройства были сопряжены ранее и это не первая
синхронизация, то запуск мастера не требуется, достаточно только запущенной
Windows версии EssentialPIM.
4. Убедитесь что брандмауэр не блокирует соединения через порт 21114 (по
умолчанию, уточните используемый порт в настройках синхронизации). Если
необходимо, измените порт на шаге сопряжения устройств во время установки
синхронизации или в настройках синхронизации.
5. Попробуйте функцию ручного соединения. Находясь в разделе СинхроПК,
вызовите меню приложения и выберите пункт Ручное соединение и введите IP
адрес и порт, предлагаемые Windows версией EssentialPIM.

2. Android EssentialPIM не видит ПК с запущенной Windows версией.
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Пути решения:

1. Убедитесь, что Windows версия EssentialPIM запущена (очень часто
пользователи просто забывают загрузить Windows версию перед
синхронизацией).
2. Если это первая попытка синхронизации, то в Windows версии должен быть
запущен мастер установки синхронизации и он должен быть на этапе
сопряжения устройств. Если устройства были сопряжены ранее и это не первая
синхронизация, то запуск мастера не требуется, достаточно только запущенной
Windows версии EssentialPIM.
3. Попробуйте несколько раз нажать кнопку сканирования.
4. Попробуйте увеличить время сканирования зайдя в Меню -> Настройки ->
СинхроПК. Мы рекомендуем установить максимальное значение. Если это решит
проблему, то постепенно уменьшайте значение пока не достигните оптимального
сочетания времени ожидания и стабильности соединения.
5. Убедитесь, что ПК и мобильное устройство находятся в одной Wi-Fi сети. Если
это не возможно по какой-либо причине, перейдите к следующему пункту.
6. Если ничего из вышеперечисленного не помогло, попробуйте альтернативные
варианты соединения, такие как соединение по USB, Bluetooth, мобильный
интернет, мобильная точка доступа Wi-Fi.

Если всё равно ничего не помогает, обратитесь, пожалуйста, в нашу службу
поддержки.

5.11.2 iOS (iPhone/iPad/iPod Touch)

EssentialPIM поддерживает синхронизацию с устройствами, работающими на
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операционной системе iOS. Для этого требуется установить iOS версию
EssentialPIM на телефон или планшет. Последняя версия всегда доступна на App
Store. Модули синхронизируются следующим образом:

Windows
EssentialPIM

          iOS EssentialPIM

Календарь    <->    Календарь (встроенный в iOS)
Дела    <->    Дела

Контакты    <->    Контакты (встроенное приложение на iOS)
Пароли    <->    Пароли

Необходимые условия для синхронизации:

- Поддерживаемые устройства: iPhone 3GS или новее, все iPad, iPOD 3 или новее
(с установленной версией iOS 5 и выше).
- iTunes установленный на ПК.
- Общая сеть между iOS устройством и компьютером. Как правило, такая сеть
уже имеется, если используется Wi-Fi маршрутизатор. Компьютер обычно
подключен к нему через кабель, в то время как мобильные устройства
подключаются через Wi-Fi. 

Установка синхронизации с iOS

Запустите мастер установки через меню Файл -> Синхронизация -> Добавить
синхронизацию -> iPhone/iPad.

Мастер установки предлагает выбрать какие модули синхронизировать с

http://itunes.apple.com/app/essentialpim/id537150179?ls=1&mt=8
http://itunes.apple.com/app/essentialpim/id537150179?ls=1&mt=8
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мобильным устройством. Для паролей предварительно нужно установить мастер-
пароль в соответствующем модуле на iOS версии EssentialPIM, затем ввести его
в данном диалоге.

Этап сопряжения устройств. Внимательно прочитайте инструкцию в данном
диалоге и убедитесь, что все условия выполнены.
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Если на данном этапе кнопка Start отсутствует, убедитесь что Windows
версия EssentialPIM находится на этапе сопряжения устройств, а также
iTunes установлен на вашем компьютере.

В момент нажатия кнопки Start, Windows версия EssentialPIM должна запросить
подтверждение соединения. Это необходимо чтобы предотвратить
несанкционированные подключения в будущем. Подтвердите запрос, после чего
синхронизация будет привязана к вашему конкретному устройству. Затем
нажмите кнопку Далее.

На последнем шаге мастера можно изменить название синхронизации, а также
выбрать ее направление.

Для запуска последующих синхронизаций нужно сделать следующее:
- запустить Windows версию EssentialPIM 
- запустить iOS версию EssenrialPIM, зайти в PC Sync и нажать Start

Если вы планируете синхронизировать несколько iOS устройств с
Windows версией EssentialPIM, то следует иметь в виду, что процедуру
установки синхронизации необходимо провести заново для каждого
нового устройства. 

Если соединиться не удалось, обратитесь к теме "Решение проблем".

5.11.2.1 Решение проблем с iOS синхронизацией

1. При запуске PC Sync в iOS версии EssentialPIM, не находится Windows
версия программы.

Пути решения:

1. Убедитесь, что вы внимательно прочитали и выполнили инструкцию по
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установке iOS синхронизации.
2. Убедитесь, что на компьютере установлен iTunes.
3. Убедитесь, что вы используете последнюю Windows версию EssentialPIM.
Проверить наличие доступных обновлений можно через меню Справка ->
Проверить обновление.
4. Если это первая синхронизация, убедитесь что мастер установки
синхронизации в Windows версии EssentialPIM запущен и находится на шаге
сопряжения устройств. Если устройства были сопряжены ранее и это не первая
синхронизация, то запуск мастера не требуется, достаточно только запущенной
Windows версии EssentialPIM.
5. Убедитесь, что iOS устройство и компьютер находятся в одной Wi-Fi сети.
6. 4. Убедитесь что брандмауэр не блокирует соединения через порт 21108 (по
умолчанию, уточните используемый порт в настройках синхронизации). Если
необходимо, измените порт на шаге сопряжения устройств во время установки
синхронизации или в настройках синхронизации.

Если ничего из вышеперечисленного не помогло, обратитесь, пожалуйста в
нашу службу технической поддержки.

5.12 EPIM Cloud

Теперь все данные EssentialPIM можно хранить онлайн при помощи сервиса EPIM
Cloud. Это очень удобно если требуется получить доступ к данным из разных
мест или поделиться ими с другими пользователями EssentialPIM. Доступ к
данным можно получить при помощи любого мобильного устройства или
компьютера, даже без установленного EssentialPIM, посредством веб-браузера.

Сервис EPIM Cloud разработан для безопасной синхронизации данных
EssentialPIM между Windows версиями программы. Доступ к данным
осуществляется исключительно по безопасному протоколу SSL, этот же
протокол  используется для осуществления банковских транзакций. При помощи
EPIM Cloud можно в равной степени эффективно и безопасно координировать
деятельность как с коллегами по работе, так и организовывать семейное
расписание.

5.12.1 Регистрация

Чтобы начать пользоваться сервисом, нужно пройти простую систему
регистрации. Для этого зайдите в меню Файл -> EPIM Cloud -> Войти.

https://cloud.essentialpim.com/
https://cloud.essentialpim.com/
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Если у вас уже есть учетная запись в EPIM Cloud, то введите свои имя
пользователя и пароль и нажмите кнопку Войти. Если вы еще не пользовались
EPIM Cloud, тогда нажмите кнопку Создать аккаунт, после чего мастер
установки проведет вас через процесс регистрации.

На первом шаге представляется общая информация о сервисе и его стоимость.
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На втором шаге автоматически открывается интернет броузер со страницей
заказа сервиса. После оформления заказа вым будут высланы имя пользователя
и пароль, их надо ввести в соответствующие поля  данного диалога.
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На третьем шаге предлагается установить какие данные будут
синхронизироваться с EPIM Cloud, а также частоту синхронизации. Следует
иметь в виду, несмотря на то, что EssentialPIM  синхронизирует все данные с
EPIM Cloud, только три модуля доступны онлайн, это - Календарь, Дела и
Контакты. Другие модули, такие как Заметки и Пароли безопасно хранятся в 
облаке и доступ к ним может получить только Windows версия EssentialPIM.

Последний шаг содержит общую информацию и завершает процесс регистрации.

5.12.2 Синхронизация с EPIM Cloud

Синхронизация с EPIM Cloud может осуществляться как автоматически так и в
ручную. По умолчанию синхронизация запускается при старте программы, при
закрытии и каждый час. Вручную синхронизацию можно всегда запустить через
меню Файл -> EPIM Cloud -> Синхронизация. 

Настройки параметров синхронизации с EPIM Cloud доступны через меню Файл -
> EPIM Cloud -> Настройки, либо через Сервис -> Настройки -> EPIM Cloud.

https://cloud.essentialpim.com/epim/
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Следует иметь в виду, что так как главной задачей EPIM Cloud является обмен
данными между Windows версиями EssentialPIM, некоторые изменения внесенные
через веб интерфейс могут быть неточно отражены в Windows версии
EssentialPIM.

Чтобы приостановить использование синхронизации EPIM Cloud с текущей базой
данных, надо воспользоваться командой Выйти в меню Файл -> EPIM Cloud.
Для того, чтобы совсем прекратить синхронизацию с сервисом, надо нажать
кнопку удалить синхронизацию в диалоге настроек Сервис -> Настройки ->
EPIM Cloud.

5.13 Работа с напоминаниями

Для встреч и дел можно добавить напоминания на определенное время. Как
только напоминание срабатывает появляется следующий диалог:
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Напомнить - откладывает выделенное напоминание на определенный период
времени указанный в выпадающем меню рядом с кнопкой.
Закрыть все - закрывает все активные напоминания.
Закрыть - закрывает выделенное напоминание(я).
Перейти к записи/Показать - переходит в модуль Календарь или Дела и
фокусируется на выделенной записи / открывает диалог редактирования
выделенной записи.

Напоминания можно отсортировать по любому из столбцов в диалоговом окне.
Для этого надо кликнуть левой кнопкой мыши по заголовку столбца. Удерживая
кнопку Ctrl на клавиатуре, можно сортировать по нескольким столбцам.

Открыть закрытый диалог с напоминаниями можно через меню Вид ->  Окно
напоминания.

5.14 Проверка орфографии

EssentialPIM имеет встроенную функцию проверки орфографии. Окно проверки
можно вызвать либо клавишей F7, либо через меню Сервис -> Проверка
орфографии.
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Диалог проверки орфографии предлагает следующие функции:

Пропустить - игнорирует предлагаемое исправление.
Пропустить все - игнорирует все аналогичные слова.
Заменить - заменяет слово с ошибкой на предложенный вариант.
Заменить все - заменяет все аналогичные слова на выбранный вариант.
Добавить - добавляет неизвестное слово в словарь.
Словари - позволяет включать/отключать словари, скачивать новые.

Настройка проверки орфографии

Настройки проверки орфографии можно открыть через меню Сервис ->
Настройки -> Орфография.

Здесь можно указать в каких модулях проверять орфографию в автоматическом
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режиме (неправильные слова будут подчёркнуты), а также включать/отключать
установленные словари.

Нажав на ссылку Скачать словари, будет открыта страница нашего сайта,
откуда можно скачать дополнительные словари и добавить их в EssentialPIM Pro.
Словари на странице хранятся в .zip формате. Для установки словаря нужно
распаковать содержимое архива:
Если используете обычную (Desktop) версию:
- Для Windows XP распакуйте архив в C:\Documents and Settings\User_Name
\Application Data\EssentialPIM\
- Для Windows Vista, 7, 8 распакуйте архив в C:\Users\User_name\AppData
\Roaming\EssentialPIM\
Если используете переносную (Portable) версию:
- Распакуйте архив в директорию с EssentialPIM Pro

Затем перезапустите EssentialPIM, новые словари будут подключены.

В случае, если EssentialPIM не видит установленные словари, проверьте
следующее:
- убедитесь, что файл был распакован в нужную папку, в соответствии
с инструкциями выше
- убедитесь что файлы словарей *.aff и *.dic попали в папку
...\EssentialPIM\Dict\ а не в ...\EssentialPIM\Dict\Dict\ 

В пути для установки присутствует системная папка AppData, которая
является скрытой по умолчанию. Перед установкой словарей следует
включить отображение скрытых папок Windows. Сделать это можно тут
- Пуск -> Панель управления -> Параметры папок -> Вид ->
Показывать скрытые папки, файлы и диски

5.15 Безопасность

В EssentialPIM аспекту безопасности уделено особое внимание. База данных
может быть зашифрована алгоритмом шифрования AES (Rijndael) 128bit.

Установка пароля на базу данных

Добавить парольную защиту можно через меню Файл -> Защита базы данных.

http://essentialpim.com/ru/get-epim/dictionaries
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После того, как база будет зашифрована, пароль будет запрашиваться при
каждой попытке открыть базу данных.
Чтобы изменить, либо снять пароль, нужно зайти в меню Файл -> Парольная
защита, после чего программа запросит пароль и после успешного ввода
откроет диалог редактирования пароля.

Теперь можно либо изменить пароль, введя новый, либо удалить парольную
защиту нажав кнопку Удалить.

Настройка парольной защиты

База данных может быть закрыта паролем не только в момент открытия, но
также и в ряде других случаев, которые можно настроить через меню Сервис -
> Настройки -> Защита.
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Блокировать базу при сворачивании в трей - доступ к файлу данных будет
заблокирован если свернуть программу на панель задач.
Блокировать базу через Х минут - блокирует базу данных, если программа не
использовалась установленный промежуток времени.
Очищать список загруженных баз при выходе - удаляет список последних
использовавшихся файлов в меню Файл.

6 Поддержка

6.1 ЧАВО (на Английском)

6.1.1 General

Q: How to make EPIM to start with another module?   
A: If you'll disable "Start with EPIM Today" in Tools -> Options -> EPIM Today than
EPIM will start with the last used module.  
 
Q: How to find my database file?   
A: EPIM stores all data in .epim database files. The default paths for EPIM databases
are:
C:\Documents and Settings\User Name\Application Data\EssentialPIM - for XP
C:\Users\User_name\AppData\Roaming\EssentialPIM - for Vista, 7 and 8
If you can't find it anyway than try to search *.epim files on your computer.
 
Q: I've tried your Free version and then purchased Pro but all my data was
lost after installation. How to recover it?   
A: EPIM stores all data in .epim database files. You only need to open (File -> Open)
your old base in EPIM Pro version. 
The default paths for EPIM Free databases are:
C:\Documents and Settings\User Name\Application Data\EssentialPIM - for XP
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C:\Users\User_name\AppData\Roaming\EssentialPIM - for Vista and Seven
If you can't find it anyway than try to search *.epim files on your computer.
 
Q: I've downloaded your EPIM but the installer would not work. What should I
do?   
A: This is because of incomplete download. Try to redownload instalation file again.
If it still tells that file is corrupted than most probably your browser or provider
cached file and every time you try to re-download it gives you cashed incomplete file
again. Try to clear browser cache or download with any download manager.
 
Q: Will my data preserve if I'll upgrade my EPIM Free to Pro?   
A: Yes, but you'll need to open (File -> Open) your old base in Pro version manually.
The default paths for EPIM Free databases are: 
C:\Documents and Settings\User Name\Application Data\EssentialPIM - for XP
C:\Users\User_name\AppData\Roaming\EssentialPIM - for Vista, 7 and 8
If you can't find it anyway than try to search *.epim files on your computer.
Note, if you upgrading from Pro trial to paid version then no need to do something.
EPIM will pick up file automatically.
 
Q: Is it possible to run EPIM on Mac OS (Linux)?   
A: Unfortunately no. Only Windows version available for now. 
 
Q: I want to install EPIM to my smartphone. What version should I buy?   
A: Regular EPIM Pro version runs on Windows desktop only and syncs with Windows
Mobile, Android, iOS and Palm devices. Add synchronization under "File -> Add
Synchronization". We also have Android version with To Do, Passwords and Notes
module. It's available on Google Play
 
Q: How can I access .epim database directly?   
A: EPIM uses Firebird database engine. You can access database directly using any
Firebird database manager. For example: http://www.mitec.cz/ibq.html Please note
that you should understand how to work with database, otherwise data will be lost.
Default l 
 
Q: My database size is 1,5Mb but backup file size is 350kb? Does backup
stores all my data?   
A: Don't worry all your data is stored in backup. It is compressed. 
 
Q: I have bought other computer but now I want to transfer all my EPIM
program and data to this new computer - can you explain to me how to do
this?   
A: You should install EPIM to a new computer and register it with your license name
and key. Then you should transfer your database and open it in EPIM (File -> Open).
You can always download EPIM installation file from our site: http://
www.essentialpim.com 
 
Q: How can I transfer data to EPIM from another PIM?   
A: Data could be transferred via supported by EPIM formats only. You can find all
supported formats in File -> Import menus. 
 
Q: How to sort records by...   
A: All EPIM items could be sorted by any field. Click on field caption in order to sort
by it. Holding Ctrl button will allow to sort by several fields. 

https://play.google.com/store/apps/details?id=com.astonsoft.android.essentialpim
http://www.mitec.cz/ibq.html
http://www.essentialpim.com
http://www.essentialpim.com
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Q: Is there a way to export in one file all EPIM settings?   
A: Yes, all settings are stored in EPIM.ini file which is stored here: C:\Documents and
Settings\User Name\Application Data\EssentialPIM - for XP C:\Users\User_name
\AppData\Roaming\EssentialPIM - for Vista, 7 and 8. Portable version stores this file
in its program  
 
Q: I purchased the EssentialPIM Pro and I would like to know whether after
one year, will I have to buy a new license?
A: You'll need to renew your license for 50% of its cost in order to receive further
upgrades for additional year. If you won't want to sign up for further upgrades then
you'll be able to use your current (for that moment) version for a lifetime.  
 
Q: Can I install EPIM to my notebook and on my PC?   
A: Yes, license agreement allows you to install EPIM on two computers belonging to
you (desktop and notebook). 
 
Q: How to change/remove database password?   
A: Do the following to remove or change password: 1. Go to File -> Password
protection 2. Enter your password and press OK 3. Press Clear or enter new
password in appeared dialog  
 
Q: EssentialPIM can not open database from a shared disk   
A: EPIM Pro can't open database file over the network directly. It connects via
Firebird server. Regular EPIM Pro version allows one user connection to database.
Please refer to Networking topic for more details.
 
Q: Is it possible to host EPIM database online?   
A: Yes, absolutely. You need "Firebird database hosting". Just one example: http://
www.techsol-host.com/firebird.php You will be able to connect to your database
from anywhere. 
  
Q: I've forgotten my database password. How can I recover it?   
A: Unfortunately it's not possible to recover database password. 
  
Q: How to print Calendar in color?   
A: You should enable corresponding option it Print options dialog (File -> Print). Note,
this feature is available in Pro version only. 

Q: After upgrade, will my data be preserved?
A: Yes, your data is stored in *.epim file and will be automatically converted to the
new version format.

Q: How do I restore Backups?
A: Backups are just *.epim files, named "file name_backup_year_month_day_time".
They can be opened from within EPIM using File -> Open menu.

Q: This morning I opened PIM and all my entries had disappeared. What do I
do now? 
A: Please search your computer for *.epim files, most probably you have opened a
wrong *.epim file or created a new one, empty.

Q: Do I need to purchase the extended download service?

http://www.techsol-host.com/firebird.php
http://www.techsol-host.com/firebird.php
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A: No you do not. You will always have full access to the latest releases. If you lose
your registered version by for example, reformatting your hard drive, you can always
visit the Download section on the web site and get the latest release there free of
charge. Once the program is downloaded, simply register it with your license details.
In order to safely remove extended download service from the cart (upon
purchasing) click on the corresponding checkbox and then click the "Update" button
on the order form. 

Q: Can I request a feature?
A: Yes, of course. We try to really attentively listen to the users- that's how
EssentialPIM is being developed. Please post your request here: Online Support
Forum -> Suggestions.

Q: Is EssentialPIM Pro translated to ... language?
A: For a current list of translations, please check here. If you do not see
EssentialPIM translated to your language - please feel free to do it, it is really easy.
Just visit the Translators' Page.

Q: Can I help make EssentialPIM Pro better?
A: Yes, you can translate EssentialPIM Pro into your native language or suggest a
feature. 

Q: In the database manager window is a function to check for invalid file links
in the database, does this only apply to attachments or does it also  check for
invalid links in notes?
A: It applies to attachments only. 

Q: EPIM became very slow. How to boost performance?
A: First, empty trash and run optimization under "File -> Database management".
If it won't help then create a new database under "File -> New -> EPIM Data File"
and save it. Then sync it with your file using EPIM Synchronizer tool which could be
downloaded from our site - http://www.essentialpim.com/get-epim Then open newly
synced file under "File -> Open"

Q: I have created a password, but how can I change my password? 
A: You need to go to File -> Password protection, erase asterisks and enter your
new password. 

Q: Password protection or Optimization option is not active
A: EPIM can't utilize database management tools while mail send/receive processes
are active. Disable "Check mail on start" option and restart EPIM. Password
protection and Optimization options will be active then.

Q: How to delete/archive old records from database?
A: We have a special tool for this - EPIM Archiver/DupeRemover. It can delete or
archive items older then particular date. Tool available from our download page - 
http://www.essentialpim.com/get-epim 

6.1.2 Calendar

Q: How to add national holidays to calendar?   
A: You can import holidays as iCal (.ics) calendar which could be downloaded from
Internet. 

http://www.essentialpim.com/get-epim/dictionaries
http://www.essentialpim.com/get-epim
http://www.essentialpim.com/get-epim
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Q: How to generate a list of upcoming birthdays and/or a list of all birthdays.   
A: You should switch calendar to Table view, filter tasks according to Birthday
(Holiday) category and set date ranges. You'll get your list then. 
 
Q: Is there a possibility to make a text search, among all appointments
scheduled in the current period?   
A: Yes, switch to Table view, then you can make search by keywords then set date
limits.

6.1.3 Notes

Q: Internet links doesn't work in Notes. The link become blue when I enter it,
but nothing happens when I Click on it.   
A: It works the same as in MS Word. You should click links holding Ctrl button. 

6.1.4 Contacts

Q: How can I delete unnecessary fields from contacts?   
A: Open any contact, select the field you want to delete and press "Delete field"
button. 
 
Q: Is it possible to add additional anniversaries to contact i.e. wife’s birthday
or any other?   
A: Yes, open any contact and press "Add field" button then set Date Field type.
EPIM will create recurring task for this event the same as for birthdays then. 
 
Q: How to add/remove columns to display in Contacts view?   
A: Right-click columns caption and choose fields to display. 
 
Q: How can I add/edit field(s) in contacts?   
A: Open any contact and press “Add field” or select a field and press “Edit field”
correspondingly. 
 
Q: How can I change fields order in Contacts?   
A: Just drag them in preferred order with left mouse button. 
 
Q: Some fields are not listed in Contacts table (main view) and some are not
necessary. How to set to display needed fields?   
A: Right-click on field name caption and choose fields to display from context menu. 
 

6.1.5 Mail

Q: "Socket Error # 10060 Connection timed out" error
A: Make sure that all servers setting were set correctly under "Tools -> Account
Settings -> Edit -> Servers Settings"
If you are not sure about what to enter then login to your account via web interface
and refer to Help area. Search for POP3/IMAP (for incoming mail) and SMTP (for
outgoing mail) settings through FAQs.

Q: How to make mail available offline for IMAP accounts?
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A: IMAP accounts download headers only by default. Press "Manage Folders" button
from Actions panel and choose what folders to download fully. Those folders
contents will be available offline then.

6.1.6 Network

Q: We've ordered additional Network license(s) but we can't access to
database. It says that we need network license. What to do?   
A: Send us all your order ID's we'll send you a proper key then. 
 
Q: I am trying to log into the program, but it only lets me login with the
SYSDBA. How can I login with another user name?   
A: You should create user account(s) to login under another user. Here are the
steps: 1. Login as SYSDBA. 2. Go to Tools -> Users. 3. Create an account(s) you
need.  
 
Q: Is there a manual or installation instructions for EssentialPIM Pro Network
available?   
A: Here goes the link to video tutorial about establishing network connection: http://
www.essentialpim.com/?r=support&pr=tutor It should help you. If you'll encounter
problems anyway let us know on which step you have problem. You can also refer to
Networking topic of this manual.
 
Q: When I’m trying to open database I get this error message: “You need
network license to connect to EPIM server”   
A: You’ve exceeded amount of simultaneously connected users to database. Regular
EPIM Pro version allows one user connection over the network. For more connections
you'll need network licenses. The number of licenses should equal the number of user
installations in your EssentialPIM Network. I.e. if you have 10 installations, you need
to purchase 10 licenses. Note, only EPIM installations need license, server can run
without EPIM installation.
 
Q: I’ve purchased Network license for each workstation, firebird is running on
the server but when I’m trying to connect to database this message appear:
“You need network license to connect to EPIM server”   
A: Make sure that exceeding EPIM copy is not connected to database. Possible
someone run EPIM client twice. Check hidden items in system trays on each
workstation.
 
Q: I can not connect to my database over the Network.   
A: Most probably firewall is to blame. Following ports need to be open to allow EPIM
Clients to communicate to the server:
- on Server machine for fbserver.exe:
       - incoming: 3050 and 3051 
       - outgoing : whole range (fbserver uses random range of ports to communicate
events)
- on Client machine for EssentialPIM.exe:
       - incoming: whole range
       - outgoing: 3050 and 3051
 
Q: EPIM is slow over the Network   
A: If your Network is fine, please make sure that the database is not being copied by

http://www.essentialpim.com/?r=support&pr=tutor
http://www.essentialpim.com/?r=support&pr=tutor
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some backup applications (or Windows built-in tools) while Network users connect to
it. 
 

6.1.7 Potable version issues

Q: I want to upgrade my U3 version but can't find it on your download page?   
A: Sorry, U3 version won't be supported anymore. You can install version for regular
drives. Download the ZIP file and unzip it on your flash drive and run
EssentialPIM.exe. Launchpad icon could be added with this tool - http://
www.softpedia.com/reviews/windows/Shortcut-Creator-4U3--Review-76269.shtml
 
Q: My EPIM is very slow on my USB stick. How can I boost it up?   
A: EPIM speed depends on your USB stick speed. Try to empty Trash and delete old
unnecessary items. You can also try to Optimize database (File -> Database
management -> Optimize). These measures should boost performance. Try also to
reformat USB drive.
 
Q: Can I use portable EPIM as desktop EPIM?   
A: This is not recommended, although you can try. Just unzip non-U3 version to your
hard drive and run EssentialPIM.exe from program folder. 
 
Q: "Cannot write key information" error when trying to enter key?   
A: This happens on some portable versions when user wants to apply new license
key. Prior to applying new code, exit EPIM, erase "EssentialPIM.ini" file which is in
EPIM installation directory. Start EPIM. It will accept key.  

Q: EPIM asks for my license code each time I open the program from a
different computer. How to prevent this? 
A: It is because you've installed Desktop version instead of Portable one. Download
correct version from our web site please - http://www.essentialpim.com/get-epim 
 

6.1.8 Synchronization issues

Q: Is it possible to sync Desktop and Portable calendar?   
A: Yes, we have a special EPIM Synchronizer tool for this. It's available from our
download page - http://www.essentialpim.com/get-epim 
 
Q: How can I sync only specified items?   
A: You can use "private" flag for this. EPIM can include/exclude private items to/from
synchronization. You can exclude private items from synchronization by unchecking
corresponding option in Tools -> Options -> General dialog. "Private" flag can be set
via context menu for any item.
 
Q: Why Outlook synchronization syncs everything except mail?
A: EPIM doesn't sync mail with Outlook. Mail sync directly with mail server if you use
IMAP account. Create IMAP accounts in both EPIM and Outlook and your mail will be
always synced.

http://www.essentialpim.com/get-epim
http://www.essentialpim.com/get-epim
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Q: I've got duplicates after synchronization/import. How to remove them?
A: We have a special tool for this - EPIM Archiver/DupeRemover. It's available from
our download page - http://www.essentialpim.com/get-epim 

6.1.9 Ordering and upgrade problems

Q: How can I get an invoice for my order?   
A: You can always get an invoice here: https://www.regnow.com/order_lookup.html 
 
Q: Still not received my CD, has it been shipped?   
A: Receiving a CD might take some time - up to a month, please be patient. In case
you do not get it after a month, please contact us. 
 
Q: I've ordered EssentialPIM recently but didn't received my license key.   
A: The key is sent automatically upon funds receipt. It means that if you paid by
card you should receive your license within minutes. For some products, automatic
message is sent, saying that the key will be sent within 2 working days. In case you
do not get it after few days, please contact us. 
 
Q: "Cannot write key information" error when trying to enter key?   
A: This happens on some portable versions when user wants to apply new license
key. Prior to applying new code, exit EPIM, erase "EssentialPIM.ini" file which is in
EPIM installation directory. Start EPIM. It will accept key. 
 
Q: What's your upgrade policy for EssentialPIM Pro?
A: By becoming a registered user you can use EssentialPIM Pro version you
purchased forever. In addition, you are entitled to free updates for one year starting
from your purchase date. 

Q: License expired after upgrade. Why?
A: According to our upgrade policy regular licence allows to upgrade for one year
after purchase date. If you got this message then it means your free upgrades
period has over. Now you need to order an upgrade (it costs 50% of full license
price) - http://www.essentialpim.com/buy. Or you can back to previous version -
http://www.essentialpim.com/vv/. If you are not sure what version you entitled for
then forward your order ID or email used for ordering to support. 

6.2 Обновление

Для проверки наличия новой версии программы, запустите EssentialPIM и
зайдите в меню Справка -> Проверить обновление.

Вы также всегда можете скачать последнюю версию программы вручную с
нашего официального сайта - www.essentialpim.com/ru/get-epim

6.3 Pешение проблем

При возникновении проблем с EssentialPIM Pro, пожалуйста, следуйте
следующим шагам для поиска решения:

Убедитесь что у вас установлена последняя версия программы

http://www.essentialpim.com/get-epim
https://www.regnow.com/order_lookup.html
http://www.essentialpim.com/buy
http://www.essentialpim.com/vv/
http://www.essentialpim.com/ru/get-epim
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Посетите наш форум, возможно, решение уже найдено www.essentialpim.com/
forum
Если решение проблемы так и не было найдено, не стесняйтесь, пишите в
нашу службу технической поддержки (на русском общаемся с удовольствием)
- epimsupport@essentialpim.com

7 Контакты

Наши контакты:

E-mail адреса
Общая информация: epiminfo@essentialpim.com
Продажи: epimsales@essentialpim.com
Техническая поддержка: epimsupport@essentialpim.com

Тел./Факс (Пожалуйста, обратите внимание, что мы не оказываем тех.
поддержку по телефону)
Факс: (+372) 650-79-37
Телефон: (+372) 5192-79-21

Почтовый адрес
Астонсофт ТОО (Astonsoft OU)
Лаки 9А
10621 Таллин

http://www.essentialpim.com/forum
http://www.essentialpim.com/forum
mailto:epimsupport@essentialpim.com
mailto:epiminfo@EssentialPIM.com
mailto:epimsales@EssentialPIM.com
mailto:epimsupport@EssentialPIM.com
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